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Package Contents

Contents of Package:

D-Link Air Xpert DI-774 2.4GHz/5GHz Tri-Mode Dualband
Wireless Router

Power Adapter — 5V DC, 3.0A
Manual on CD

Quick Installation Guide
Ethernet Cable

Note: Using a power supply with a different voltage rating than the one included with the
DI-774 will cause damage and void the warranty for this product.

If any of the above items are missing, please contact your reseller.

System Requirements For Configuration:

m Computer with Windows, Macintosh, or Linux-based
operating system with an installed Ethernet adapter
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Introduction

At up to five times the speed of previous wireless devices, you can work faster and more
efficiently, increasing productivity. With the DI-774, bandwidth-intensive applications like
graphics or multimedia will benefit significantly because large files are able to move
across the network quickly. This versatile wireless router also features four times the
number of non-overlapping channels than a device that supports only 802.11g, so more
users can access the network.

Support for all three standards (802.11g; 802.11a; 802.11b) means that you can grow

your network without having to worry about legacy wireless equipment being incompatible
with newer compliant devices from other manufacturers. This also allows network
administrators to partition the usage of the dualband by segmenting users and creating
special access privilege networks for classified document transfer and communications.

With the DI-774 you can securely connect to wireless clients on the network using
802.1x for wireless user authentication, as well as WPA (Wi-Fi Protected Access™)
providing you a much higher level of security for your data and communications than
has previously been available.

Through its easy-to-use Web-based user interface, the DI-774 lets you control the
information that is accessible to those on the wireless network, whether from the Internet
or from your company’s server:

Content Filtering — Easily applied content filtering based on MAC Address, IP Address,
URL and /or Domain Name.

Filter Scheduling — Filters can be scheduled to be active on certain days or for a
duration of hours or minutes.

Network Address Translation — NAT protects the DI-774 and its users from outside
intruders gaining access to your private network

VPN Multiple/Concurrent Sessions — Supports multiple and concurrent IPSec and

PPTP sessions, so multiple users behind the DI-774 can access corporate networks
through various VPN clients more securely.
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Connections - Back Panel of Unit

All Ethernet Ports (WAN and LAN)
are auto MDI/MDIX, meaning you can
use either a straight-through or a
crossover Ethernet cable.

Pressing the
Reset Button
restores the
router to its
original factory
default settings.

Auto MDI/MDIX
LAN ports
automatically
sense the cable
type when
connecting to
Ethernet-enabled
computers.

The Auto MDI/MDIX Receptor
WAN port is the for the
connection for the Power
Ethernet cable to Adapter
the Cable or DSL

modem
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Features

Fully compatible with the 802.11a and 802.11g standards to provide a wire-
less data rate of up to 54Mbps

Backwards compatible with the 802.11b standard to provide a wireless data
rate of up to 11Mbps

WPA (Wi Fi Protected Access™) authorizes and identifies users based on a
secret key that changes automatically at a regular interval, for example:

B TKIP (Temporal Key Integrity Protocol), in conjunction with a RADIUS
server, changes the temporal key every 10,000 packets, ensuring greater
security

M Pre-Shared Key mode means that the home user, without a RADIUS
server, will obtain a new security key every time the he or she connects
to the network, vastly improving the safety of communications on the
network.

802.1x Authentication in conjunction with the RADIUS server verifies the
identity of would be clients

Utilizes OFDM technology (Orthogonal Frequency Division Multiplexing) to
ensure strong wireless signals for both 802.11g and 802.11a

User-friendly configuration and diagnostic utilities
Operates in the 2.4GHz and 5GHz frequency ranges

Connects multiple computers to a Broadband (Cable or DSL) modem to
share the Internet connection

Advanced Firewall features

B Supports NAT with VPN pass-through, providing added security
B MAC Filtering

M P Filtering

B URL Filtering

B Domain Blocking
H Scheduling

DHCP server supported enables all networked computers to automatically
receive IP addresses

Web-based interface for Managing and Configuring

Access Control to manage users on the network

Supports special applications that require multiple connections

Equipped with 4 10/100 Ethernet ports, 1 WAN port, Auto MDI/MDIX 6
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LEDs - Front Panel of Unit

LED stands for Light-Emitting Diode. The DI-774 has the following LEDs:

Power

A solid light
indicates a proper
connection to the
power supply

Status

A blinking light
indicates that the
DI-774 is ready

A — T R A = T

D-Linl

WAN LED

A solid light
indicates connec-
tion on the WAN
port. This LED
blinks during data
transmission

WLAN LEDs for 11a
and 11g wireless net-
work segments.

A solid light indi-
cates that the
wireless segment is
ready. The LEDs
blink during wireless
data transmission

Local

Network LEDs

A solid light indicates
a connection to an
Ethernet-enabled
computer on ports 1-
4. The LEDs blink
during data transmis-
sion
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Wireless Basics

D-Link wireless products are based on industry standards to provide easy-to-use and
compatible high-speed wireless connectivity within your home, business or public access
wireless networks. D-Link wireless products will allow you access to the data you want,
when and where you want it. You will be able to enjoy the freedom that wireless networking
brings.

A WLAN is a cellular computer network that transmits and receives data with radio
signals instead of wires. WLANs are used increasingly in both home and office
environments, and public areas such as airports, coffee shops and universities. Innovative
ways to utilize WLAN technology are helping people to work and communicate more
efficiently. Increased mobility and the absence of cabling and other fixed infrastructure
have proven to be beneficial for many users.

Wireless users can use the same applications they use on a wired network. Wireless
adapter cards used on laptop and desktop systems support the same protocols as
Ethernet adapter cards.

People use wireless LAN technology for many different purposes:

Mobility - Productivity increases when people have access to data in any location
within the operating range of the WLAN. Management decisions based on real-time
information can significantly improve worker efficiency.

Low Implementation Costs — WLANSs are easy to set up, manage, change and
relocate. Networks that frequently change can benefit from WLANs ease of
implementation. WLANSs can operate in locations where installation of wiring may be
impractical.

Installation and Network Expansion - Installing a WLAN system can be fast
and easy and can eliminate the need to pull cable through walls and ceilings. Wireless
technology allows the network to go where wires cannot go - even outside the home or
office.

Scalability — WLANs can be configured in a variety of topologies to meet the needs of
specific applications and installations. Configurations are easily changed and range
from peer-to-peer networks suitable for a small number of users to larger infrastructure
networks to accommodate hundreds or thousands of users, depending on the number

of wireless devices deployed.

Inexpensive Solution - Wireless network devices are as competitively priced as
conventional Ethernet network devices.
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Wireless Basics (continued)

Standards-Based Technology

The DI-774 Wireless Broadband Router utilizes the new 802.11g standard, in addition
to the 802.11a and 802.11b standards.

The IEEE 802.119g standard is an extension of the 802.11b standard. It increases the
data rate up to 54 Mbps within the 2.4GHz band, utilizing OFDM technology.

This means that in most environments, within the specified range of this device, you will
be able to transfer large files quickly or even watch a movie in MPEG format over your
network without noticeable delays. This technology works by transmitting high-speed
digital data over a radio wave utilizing OFDM (Orthogonal Frequency Division Multiplexing)
technology. OFDM works by splitting the radio signal into multiple smaller sub-signals
that are then transmitted simultaneously at different frequencies to the receiver. OFDM
reduces the amount of crosstalk (interference) in signal transmissions.

Installation Considerations

The D-Link Air Xpert DI-774 lets you access your network, using a wireless connection,
from virtually anywhere within its operating range. Keep in mind, however, that the number,
thickness and location of walls, ceilings, or other objects that the wireless signals must
pass through, may limit the range. Typical ranges vary depending on the types of materials
and background RF (radio frequency) noise in your home or business. The key to

maximizing wireless range is to follow these basic guidelines:

Keep the number of walls and ceilings between the DI-774 and other network
devices to a minimum - each wall or ceiling can reduce your D-Link wireless
product’s range from 3-90 feet (1-30 meters.) Position your devices so that
the number of walls or ceilings is minimized.

Be aware of the direct line between network devices. A wall that is 1.5 feet
thick (.5 meters), at a 45-degree angle appears to be almost 3 feet (1 meter)
thick. At a 2-degree angle it looks over 42 feet (14 meters) thick! Position
devices so that the signal will travel straight through a wall or ceiling (instead
of at an angle) for better reception.

Building Materials can impede the wireless signal - a solid metal door or
aluminum studs may have a negative effect on range. Try to position wireless
devices and computers with wireless adapters so that the signal passes
through drywall or open doorways and not other materials.

Keep your product away (at least 3-6 feet or 1-2 meters) from electrical
devices or appliances that generate extreme RF noise.
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Getting Started

Internet

¥ Cable/DSL Modem

DI-774

Computer 3
Desktop PC or Laptop
(Wireless Adapter Required)

Computer 1
Desktop PC or Laptop

Computer 2
Desktop PC or Laptop
(Wireless Adapter Required)

For a typical wireless setup at home (as shown above),
please do the following:

o You will need broadband Internet access (a Cable or DSL-subscriber line into
your home or office)

e Consult with your Cable or DSL provider for proper installation of the modem

9 Connect the Cable or DSL modem to the DI-774 Wireless Router (see the
printed Quick Installation Guide included with your router.)

If you are connecting a desktop computer to your network, install the D-Link Air
Xpert DWL-AG520 wireless PCl adapter into an available PCI slot on your
desktop computer.

(See the printed Quick Installation Guide included with the network adapter.)

Install the D-Link DWL-AG650 wireless Cardbus adapter into a laptop computer.
(See the printed Quick Installation Guide included with the DWL-AG650.)

=y, Install the D-Link DFE-530TX+ wireless Cardbus adapter into a desktop com-
_6 puter. The four Ethernet LAN ports of the DI-774 are Auto MDI/MDIX and will
work with both Straight-through and Crossover cable.
(See the printed Quick Installation Guide included with the DFE-530TX+.) 10
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Using the Configuration Menu

Whenever you want to configure your network or the DI-774, you can access the
Configuration Menu by opening the web-browser and typing in the IP Address of the
DI-774. The DI-774 default IP Address is shown here:

o h bb File  Edit Yiew Favorites Tools  Help
[ pen the web browser
- A
| Type in the IP Address of Q-0 HED,
the Router (http://192.168.0.1) address | €] hitp://192.168.0.1
Note: if you have changed the default IP Address gennectiog S 1EE0.]
assigned to the DI-774, make sure to enter the @\
correct IP Address. R
u Type admin in the User prrne
Name field j d }c adrin v}
] Leave the Password i TR
blank
[ | Click OK

Home > Wizard

Air X pert, AG

The Home>Wizard screen will appear.

. 3 DI-774
Please refer to the Quick Installation ‘/l NUCo Ml Advonced _Tools ___Status ___Help |
Guide for more information regarding the =z | e
Setup Wizard. = ey e e e e ”.:-::-_.;
TR e et
_— ]
°
Help
[~ |
These buttons appear a Clicking Apply will save changes made to the page
on most of the configu- Apply
ration screens in this
section. Please click on {3 Clicking Cancel will clear changes made to the page
the appropriate button Cancel
at the bottom of each
screen after you have o Clicking Help will bring up helpful information regarding the page
made a configuration Help
change.

@ Clicking Restart will restart the router. (Necessary for some changes.)
Restart

11
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Using the Configuration Menu (continued)

Home > Wireless > Open or Shared

D-Link

AirXpert, AG
Tri-Mode Dualband Wireless Router

5

Building Networks for People

Advanced Tools _Status Help |

O 80211y ® B02.11a
These are the wireless settings for the AP(Access Point)Portion.

Wireless Settings

SSID : |default |
Channel : E’
Authentication : & Open System O Shared kKey O wpa O WPA-PSK
WEP : (O Enabled ® Disabled
WEP Encryption : |@
Key Type m

BT Keyl : @ (0000000000 |
Key2 : ¢ [onooononnn |
oHce Key3: ¢ 0000000000 |
Keyd : ¢ [0000onooon |

9 90O

Apply Cancel Help

Wireless Settings-

Choose 802.11a or 802.11g. Here, 802.11a is selected.
802.11a uses the 5GHz frequency range and can support speeds of up to 54Mbps.

802.11g uses the 2.4GHz frequency range and can support speeds of up to 54Mbps.
802.11g is also backwards compatible with 802.11b.

SSID-

“default” is the default setting. All devices on the network must share the same SSID. If
you change the default setting, the SSID may be up to 32 characters long.

12
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Using the Configuration Menu (continued)

Home > Wireless > Open or Shared (continued)

Channel- 52 is the default channel for 802.11a.
6 is the default channel for 802.11g.
All devices on the network must share the same channel.

Authentication- Open System - communicates the key across the network

Shared Key - devices must have identical WEP settings in or-
der to communicate in the network

WPA - Wi-Fi Protected Access authorizes and authenticates
users onto the wireless network. WPA uses stronger security
than WEP and is based on a key that changes automatically at
a regular interval. This mode requires a RADIUS server in the
network.

WPA-PSK - Pre-Shared Key mode means that the wireless cli-
ent and the router must have the same passphrase in order to

establish the wireless connection. A RADIUS server is not re-
quired with PSK.

WEP- Select Enabled or Disabled. Disabled is the default setting.

WEP Encryption- Selectthe level of encryption desired: 64, 128 or 152-bit

& All the devices on your network must share the same wireless
settings in order to communicate.

Key Type- Select HEX or ASCII

Hexadecimal digits consist of the numbers 0-9 and the letters A-F
ASCII (American Standard Code for Information Interchange) is a code for repre-

senting English letters as numbers from 0-127

Keys 1-4- Input up to 4 WEP keys; select the one you wish to use.

13

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the Configuration Menu (continued)

Authentication-

802.1x

Lifetime-

Radius Server 1-

Radius Server 2-

Home > Wireless > WPA
D-Link Air Xpert A@;

Building Netwarks for People
Tri-Mode Dualband Wireless Router

DI-774 l
| Home Advanced  Tools Status Help
‘/' Wireless Settings @ 802.11g O 802.11a
These are the wireless settings for the AP{Access Point)Portion.
Wizard
S50 [defaul |
Channel 1| 1 v
Authentication : O Open System O Shared Key @ wpa O WPA-PSK
WAN Lifetime
RADIUS Server 1 P [n000 |
—_—
N Port [mz ]
Shared Secret |
Conce RADIUS Server 2 IP [ppoo ]
(Optional) T 1
Port o |
Shared Secret | ‘
9 90
Apply Cancel Help

WPA (Wi-Fi Protected Access) is selected.

Wi-Fi Protected Access authorizes and authenticates users onto
the wireless network. WPA uses stronger security than WEP
and is based on a key that changes automatically at a regular
interval. This mode requires the inclusion of a RADIUS server in
your network.

802.1x Authentication is a first line of defense against intrusion.
In the Authentication process the server verifies the identity of
the client attempting to connect to the network. Unfamiliar cli-
ents are denied access.

Select 5, 15, 30 minutes, or 1 or 8 hours, or 1 day for the authen-
tication period. After this period expires, a new key will auto-
matically be generated.

IP - Enter the IP Address of the RADIUS server.

Port - Enter the port number that your RADIUS server uses for
Authentication. The default setting of 1812 is the port setting for
many RADIUS servers.

Shared Secret - Enter the Shared Secret. The Shared Secret
must be the same as the Shared Secret on your RADIUS server.

Optional. If you have a second RADIUS server, you will
input the same information as shown above. 14
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Using the Configuration Menu (continued)

Home > Wireless > WPA-PSK

D-Link

Building Networks for People -Airxpe,gg;A@

Tri-Mode Dualband Wireless Router

LT I Advanced  Tools " Status Help

Wireless Settings @ 802.11g © 802.11a
These are the wireless settings for the AP(Access Point)Portion.

SSID : |default

Channel . |B V|
Wireless Authentication : O Open System O Shared Key O Wpa & WPA-PSK
Passphrase : |
[

|
WAN 9 OO0

Apply Cancel Help

Authentication- WPA-PSK - Pre-Shared Key mode means that the wireless cli-
ent and the router must have the same passphrase in order to
establish the wireless connection. A RADIUS server is not re-
quired with PSK.

Passphrase- Enter a passphrase for the router. The RADIUS server should
use the same passphrase (secret key) as the router.

15
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Using the Configuration Menu (continued)

Dynamic
IP Address-

Host Name-

MAC Address-

Clone
MAC Address-

Primary/Secondary
DNS-

MTU-

Home > WAN > Dynamic IP Address

Building Networks for Paople
Tri-Mode Dualband Wireless Router

DI-774 |
b Home Advanced Tools Status Help
Please select the appropriate option to connect to your ISP,
Wizard
@ Dynamic IP Address Choose this option to obtain an [P address automatically
from your ISP, (For most Cable modem users)
r Wireless O Static IP Address Choose this option to set static IP information provided to
you by your ISP.
© PPPoE Chaoose this option if your ISP uses PPPoE. (For most
DSL users)
WAN O Others PPTP and BigPond Cable
O PPTP (for Europe use only)
LAN
Host Name (D774 | (ontional)
e — e ——
DHCP WAL Ailifess o [fi1 J-[ez ][5 ]-[44 ]-[56 ] faptianai
Clone MAC Address
Primary DNS Address [0.0.0.0 ]
Secondary DNS Address |0.0.0.0 j‘(mptmnal)
WU [1500 |
Apply Cancel Help

Most Cable modem users will select this option to obtain an IP
Address automatically from their ISP (Internet Service Pro-
vider).

This is optional, but may be required by some ISPs. The host
name is the device name of the Router.

The default MAC Address is set to the WAN's physical inter-
face MAC address on the Router.

Copy the MAC address of the Ethernet card installed by your ISP,
and replace the WAN MAC address with this Ethernet card MAC
address. Itis not recommended that you change the default MAC
address unless required by your ISP.

Enter a DNS Address if you do not wish to use the one provided
by your ISP. (DNS is short for Domain Name System. It trans-
lates domain names into IP Addresses).

Enter an MTU value only if required by your ISP. Otherwise,
leave this section to its default setting of 1500. (MTU is short
for Maximum Transfer Unit. Messages longer than the MTU

will be divided into smaller units for transmission).
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Using the Configuration Menu (continued)

Static IP Address-

IP Address-

Subnet Mask-

ISP
Gateway Address-

Primary/
Secondary DNS-

MTU-

Home > WAN > Static IP Address

Building Networks for People
Tri-Mode Dualband Wireless Router

DI-774 |
N ;1,3 Advanced  Tools Status Help
‘/‘ WAN Settings
Please select the appropriate option to connect to your ISP,
—
O Dynarmic IP Address Choose this option to obtain an IP address autoratically
frorn your ISP. (For rost Cable modem users)
EwTTeal @ Static IP Address Choose this option to set static IP information provided to
Wireless you by your ISP
) PPPoE Choose this option if your ISP uses PPPoE. (For most
DSL users)
O Others FPTF and BigPand Cable
O PPTP (for Europe use only)
LAN Static
IP Address 10.0.0.0 (assigned by your ISP}
W Subnet Mask ED_D 0

ISP Gateway Address |0,0.0.0
Primary DNS Address iEEI_[I i}
Secondary DNS Address | 0.0.0.0 {optional)

MTU 1500 |

2 90

Apply Cancel Help

Select this option to set static IP information provided to you
by your ISP.

Input the IP Address provided by your ISP

Input your Subnet mask. (All devices in the network must
have the same subnet mask.)

Input the Gateway address

Enter a DNS Address if you do not wish to use the one pro-
vided by your ISP. (DNS is short for Domain Name System. It
translates domain names into IP Addresses).

Enter an MTU value only if required by your ISP. Otherwise,
leave this section to its default setting of 1500. (MTU is short
for Maximum Transfer Unit. Messages longer than the MTU

will be divided into smaller units for transmission). 17
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Using the Configuration Menu (continued)

4 )
Please &
be sure
to remove any
existing PPPoE
client software
installed on your
computers.

\. J

PPPoOE-

User Name-

Password-

Retype Password-

Service Name-
IP Address-

Home > WAN > PPPoE
D-Link

Building Networks for People

AirXpert AG

Tri-Mode Dualband Wireless Router

DI-774 ‘

il
|

Home Advanced Tools Status Hel

WAN Setlings

Please select the appropriate option to connect to your ISP

—
Wizard © Dynamic IP Address Choose this option to obtain an IP address automatically

from your ISP. (For most Cable modem users)

Choose this option to set static 1P information provided to

you by your ISP,

© Static IP Address
' Wireless

@& PPFoE Chonse this option if your ISP uses PPPoE. (For most
DSL users)
O Others PPTF and BigPond Cable
) PPTP (for Europe use anly)
PPoE
LAN PPPoE
@ Dynamic PPPoE O Static PPPoE
User Mame I
P |test0]
DHCP I ‘
Pasgword | |

Retype Password

Sewvice Name | ‘(nptmma\)

IP Address oo ]
Primary DNS Address
Secondary DNS Address E (optional)
Maximum Idle Time ’DMmules
Auto-reconnect @ Enabled O Disabled
9 00

Apply Cancel Help

Choose this option if your ISP uses PPPoE. (Most DSL users
will select this option).

Dynamic PPPOE- receive an IP Address automaticsally from
your ISP.

Static PPPoE- you have an assigned (static) IP Address.
Your PPPoE username provided by your ISP.
Your PPPoE password provided by your ISP.

Re-enter the PPPoE password
Enter the Service Name provided by your ISP (optional).

This option is only available for Static PPPoE. Enter the static
IP Address for the PPPoOE connection.

18
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Using the Configuration Menu (continued)

Home > WAN > PPPoE continued

Primary/Secondary Enter a DNS Address if you do not wish to use the one provided

DNS-

Maximum
Idle Time-

MTU-

Auto-reconnect-

LAN is short for Lo-
cal Area Network.
This is considered
your internal network.
These are the IP set-
tings of the LAN inter-
face for the DI-774.
These settings may
be referred to as Pri-
vate settings. You
may change the LAN
IP Address if needed.
The LAN IP Address
is private to your in-
ternal network and
cannot be seen on
the Internet.

IP Address-

Subnet Mask-

Local Domain
Name-

by your ISP. (DNS is short for Domain Name System. It trans-
lates domain names into IP Addresses).

Enter a maximum idle time during which Internet connection is
maintained during inactivity. To disable this feature, enter zero
or enable Auto-reconnect.

Maximum Transmission Unit-1472 is default-you may need to
change the MTU to conform with your ISP.

If enabled, the DI-774 will automatically connect to your ISP af-
ter your system is restarted or if the connection is dropped.

Home > LAN
D-Link

Building Networks for Peaple

AirXpert. A@

Tri-Mode Dualband Wireless Router

DI-774 |
N [N Advanced  Tools Status Help
‘/‘ LAN Settings
The IP address of the D774
Wizard R
IP Address 182.168.0.1 \
—_— Subnet Mask |esezemzmen |
Wireless
Local Domain Name | |(om|anal)
— 9 00

e Apply Cancel Help

DHCP

‘[

The IP Address of the LAN interface. The default IP Asddress is:
192.168.0.1

The subnet mask of the LAN interface.
The default subnet mask is 255.255.255.0

The domain name assigned to the router
19
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Using the Configuration Menu (continued)

DHCP stands for Home > DHCP

Dynamic Host -
Control Protocol. The R;;I;'Hlplf

DI-774 has a built-in

AirXpert, AG

Tri-Mode Dualband Wireless Router

DHCP server. The DI-774 |
DHCP Server will LT Advanced  Tools Status Help
aUtomatlcally aSSIgn T}‘we b\—??d :-em be setup as a DHCP Senver to distribute IP addresses to the LAN
an IP Address to the netwark
computers on the DHCP Server ® Enabled O Disabled
LAN/private network. i L
Be sure to set your Bl JE2aRgrese 192. 168 0. [188 |
Lease Time ‘@I

computers to be ™ Wan
DHCP clients by
setting their TCP/IP
settings to “Obtain

Static DHCP is used to allow DHCP server to assign same IP to specific MAC address

O Enabled @ Disabled

dl

an IP Address DHCP Narme I

Automatically.” When P 192,168 0. |

you turn your MAG Address 0 A [
computers on, they DHCP Client [winep 00-50-BAFFFF-FE v [Clone |

will automatically

load the proper TCP/ 2 90
IP settings provided ADpl Rt T
by the DI-774. The 7

DHCP Server Wl” Hus‘t’f‘\l‘ar‘l;e' \F‘.Ad.drésa MAC Address

automatically
allocate an unused IP Dynamic DHCP Client List
Address from the |P Host Name P Address MAC Address Expired Time

i 152.168.0.100  00-50-BA-FF-FF-FE  Aprf03/2003 00.00:17
Address pool to the R
requesting computer.
You must specify the starting and ending address of the IP Address pool.

DHCP Server- Select Enabled or Disabled

Starting

IP Address- The starting IP Address for the DHCP server’s IP assignment
Ending

IP Address- The ending IP Address for the DHCP server’s IP assignment
Lease Time- The length of time of the DHCP lease

Static DHCP- Enable the Static DHCP server to assign the same IP Address

to a MAC Address that you specify here. This prevents the prob-
lems sometimes encountered with changing IP Addresses
Static & Dynamic
DHCP Client Displays a list of Static and Dynamic DHCP clients assigned by

Table- the router 20

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the Configuration Menu (continued)
Advanced > Virtual Server

D-Link

Building Metworks for Peaple

AirXpert, AG

Tri-Mode Dualband Wireless Router

DI-774 |
N [ __Home ULV TER Tools Status Help
‘,""' Virtual Server
Yirtual Server is used to allow Internet users access to LAN services.
Mol O Enabled O Disabled
Mame | |[ Clear]
Applications Private [P I:
Protocaol Type @|
Filters Private Port |_|
Public Port | |
Firewall Schedule O Always
© Fram time |00 v |- |00 v|[AM v[1a0]00 | [00 v|[AM +]
DMZ day[Sun_ ¥1o[Sun ]

92 OO0
Performance o J

Apply Cancel Help
Marne Private IP Protocol Schedule

i

Yirtual Server FTP 0.0.00 TCP 21421 always 4%
Yirtual Server HTTP 0.0.00 TCP 80/80 always [Ei]
Yirtual Server HTTPS 0.0.00 TCP 4437443 abways 4%
Yirtual Server DNS 0.0.00 UDP 53/53 abways Ei]
Yirtual Server SMTP 0.0.00 TCP 25/25 always 4%
Yirtual Server POP3 0.0.00 TCP 1104110 always [Ei]
Yirtual Server Telnet 0.0.00 TCP 23/23 always 4%
IPSec 0.0.00 UDP 500400 abways Ei]
PPTP 0.0.00 TGP 17231723 abways 4%
Methieeting 0.0.00 TCP 17201720 abways Ei]

The DI-774 can be configured as a virtual server so that remote users accessing Web
or FTP services via the public IP Address can be automatically redirected to local
servers in the LAN (Local Area Network).

The DI-774 firewall feature filters out unrecognized packets to protect your LAN
network so all computers networked with the DI-774 are invisible to the outside world.
If you wish, you can make some of the LAN computers accessible from the Internet
by enabling Virtual Server. Depending on the requested service, the DI-774 redirects

the external service request to the appropriate server within the LAN network.

21

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the Configuration Menu (continued)
Advanced > Virtual Server continued

The DI-774 is also capable of port-redirection meaning incoming traffic to a particular
port may be redirected to a different port on the server computer.

Each virtual service that is created will be listed at the bottom of the screen in the
Virtual Servers List. There are pre-defined virtual services already in the table. You
may use them by enabling them and assigning the server IP to use that particular

virtual service.

Virtual Server- Select Enabled or Disabled

Name- Enter the name referencing the virtual service

Private IP- The server computer in the LAN (Local Area Network) that will be
providing the virtual services.

Protocol Type- The protocol used for the virtual service

Private Port- The port number of the service used by the Private IP computer

Public Port- The port number on the WAN (Wide Area Network)side that will

be used to access the virtual service.

Schedule- The schedule of time when the virtual service will be enabled.
The schedule may be set to Always, which will allow the
particular service to always be enabled. If it is set to Time,
select the time frame for the service to be enabled. If the
system time is outside of the scheduled time, the service will
be disabled.

Example #1:

If you have a Web server that you wanted Internet users to access at all times, you
would need to enable it. Web (HTTP) server is on LAN (Local Area Network)
computer 192.168.0.25. HTTP uses port 80, TCP.

Name: Web Server

Private IP: 192.168.0.25

Protocol Type: TCP

Private Port: 80

Public Port: 80

Schedule: always
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Using the Configuration Menu (continued)
Advanced > Virtual Server continued

Virtual Servers List
MNarne Private IP Protocol achedule
B Wirtual Server HTTP 192.168.0.25 TCP 80420 always LTl

; Click on this icon to edit the virtual service

;"' ]l Click on this icon to delete the virtual service

Example #2:

If you have an FTP server that you wanted Internet users to access by WAN port
2100 and only during the weekends, you would need to enable it as such. FTP
server is on LAN computer 192.168.0.30. FTP uses port 21, TCP.

Name: FTP Server
Private IP: 192.168.0.30
Protocol Type: TCP
Private Port: 21

Public Port; 2100

Schedule: From: 01:00AM to 11:00PM, Sat to Sun

All Internet users who want to access this FTP Server
must connect to it from port 2100. This is an example of
port redirection and can be useful in cases where there
are many of the same servers on the LAN network.
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Using the Configuration Menu (continued)

Advanced > Applications

D-Link AirXpert AG

Rurllding Motwearks for Peaple
Tri-Mode Dualband Wireless Router

Spacial Apglication is uzed 10 run applications that require multiple connections.

DI-774 l

‘/,l-‘
=

R © Enabled ) Disabled
Marry | Clear |
ians | Trugger Mg
Trgger Type | TEF =
Filters Public Pon
Bubihie Type ToE =
T v IR X
S | Applicatinns | st Apply Cancel Help
T MAME Trigger Public
Batle net 6112 6112

4

Dislpad 7175 51200-51201,51210 £} ]
cun 201% 2000-205E,2 2051,2065, 2085 2010-2020 35
)]

4

i

il

Parformance MSH Gamng Zone 47624 2300.240 0
P to-Phone 20531212 5024220
Cick Tame 4

Some applications require multiple connections, such as Internet gaming, video
conferencing, Internet telephony and others. These applications have difficulties
working through NAT (Network Address Translation). Special Applications makes
some of these applications work with the DI-774. If you need to run applications that
require multiple connections, specify the port normally associated with an application
in the “Trigger Port” field, select the protocol type as TCP or UDP, then enter the
public ports associated with the trigger port to open them for inbound traffic.

The DI-774 provides some predefined applications in the table on the bottom of the
web page. Select the application you want to use and enabile it.

Note! Only one PC can use each Special Application tunnel.

Name: This is the name referencing the special application.

Trigger Port: This is the port used to trigger the application. It can be either
a single port or a range of ports.

Trigger Type: This is the protocol used to trigger the special application.

Public Port: This is the port number on the WAN side that will be used to

access the application. You may define a single port or a
range of ports. You can use a comma to add multiple ports or
port ranges.

Public Type: This is the protocol used for the special application. o4
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Using the Configuration Menu (continued)

Advanced > Filters > IP Filters

AirXpert, /AE;

Tri-Mode Dualband Wireless Router

l [ Home BT LT B Tools Status Help

Filters are used to allow or deny LAN users from accessing the Internet

f
L i ® IP Filters © URL Blocking
O MAC Filters © Domain Blocking

B r—

Use IP Filters to deny LAN IP addresses access to the Internst

| Filters I © Enabled © Disabled
-
E—

" -
Firewall Port |*| i |7|

Protocaol Type |fc? =

DMz Scheduls © Always
—— & tma[00 ][00 ] [AM ] 1o [00 ] - [30 ] [t ]
Performance day ’m‘ 1o ‘Suﬂ—\'l
2 90
> Filter List Apply Cancel Help
IP Range Protocal Schedule
* TCP 2021 always ][]
- TCP 80 always [E{i)
i TCP 443 always EiT}
* UDP 53 always E|T}
* TCP 25 always E{7]
- TCP 110 always £
% ICMP 8 always E{7]
* TCR23 always EiT}

Filters are used to deny or allow LAN (Local Area Network) computers from accessing
the Internet. The DI-774 can be setup to deny internal computers by their IP or MAC
addresses. The DI-774 can also block users from accessing restricted web sites.

IP Filters- Use IP Filters to deny LAN IP Addresses from accessing the
Internet. You can deny specific port numbers or all ports for
the specific IP Address.

IP- The IP Address of the LAN computer that will be denied
access to the Internet.

Port- The single port or port range that will be denied access to the
Internet.
Protocol Types- Select the protocol type
Schedule- This is the schedule of time when the IP Filter will be enabled.
25
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Using the Configuration Menu

Advanced > Filters > URL Blocking
.
Dg I‘“f‘lf AirXpert. A@
Tri-Mode Dualband Wireless Router

[ Home EVTTCUMR Tools  Status  Helg

Filters

DI-774 '

Filters are used to allow or deny LAN users from accessing the Internet,

et eeever O IP Filters & URL Blocking
O MAL Filters O Domain Blocking

Applications URL Blocking

Block those URLs which contain keywords listed below.

] )g

Filters O Enabled @ Disabled

F oo it
Firewall

DMZ

9 OO

Apply Cancel Help

f———
Performance

URL Blocking is used to deny LAN computers from accessing specific web sites. A
URL is a specially formatted text string that defines a location on the Internet. If any
part of the URL contains the blocked word, the site will not be accessible and the web
page will not display.

Filters- Select the filter you wish to use; in this case, URL Blocking
was chosen.

URL Blocking- Select Enabled or Disabled.

Keywords- Block URLs which contain the keywords listed below.

Enter the keywords in this space.
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Using the Configuration Menu

Advanced > Filters > MAC Filters

Building Networks for Peaple
Tri-Mode Dualband Wireless Router

BT Advanced BRI  Status Help
Filters

DI-774 |

il

i

il
—

Filters are used to allow or deny LAN users from accessing the Intermet

[¥irtmol Server C IF Filters O URL Blocking
@ MAC Filters © Domain Blocking

Applications

MAC Filters

Use MAC address to allow or deny computers access to the netwark

@ Disabled MAC Filters
O Only allow computers with MAC address listed below to access the netwark
© Only deny computers with MAC address listed below to access the network

" Firewall Narhe | \
o macaddress| [ [ |-[ |-[ |-[ ]
DHCP Client [m 000059436132 3]
X
MAC Filter List Apply Cancel Help
K MAG Address

Use MAC (Media Access Control) Filters to allow or deny LAN (Local Area Network)
computers by their MAC addresses from accessing the Internet. You can either
manually add a MAC address or select the MAC address from the list of clients that
are currently connected to the Broadband Router.

Filters-

MAC Filters-

Name-

MAC Address-

DHCP Client-

Select the filter you wish to use; in this case, MAC filters was
chosen.

Choose to Disable MAC filters, or choose to allow or deny
MAC addresses listed below.

Enter the name here.

Enter the MAC Address of the client that will be allowed or de-
nied access.

Select a DHCP client from the pull-down list; click Clone to
copy that MAC Address.
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Using the Configuration Menu (continued)

Advanced > Filters > Domain Blocking

Tri-Mode Dualband Wireless Router

BT Advanced EETE Status Help
-~

DI-774 l

Filters are used to allow or deny LAN users from accessing the Intemet

[V St ServeY © I Filters © URL Blocking
© MAC Filters @ Domain Blacking

 w—
Applications T YTy
Domair

Jomain Bloc
® Disabled
O Allow users ta access all domains except "Blocked Damains”
© Deny users to access all domains except "Permitted Damains”

king

Firewall

g

B
DMZ
| |
B

@ 900

Apply Cancel Help

Domain Blocking is used to allow or deny LAN (Local Area Network) computers from
accessing specific domains on the Internet. Domain blocking will deny all requests to a
specific domain such as http and ftp. It can also allow computers to access specific
sites and deny all other sites.

Filters-

Domain Blocking
Disabled-

Allow-
Deny-

Permitted
Domains-

Blocked Domains-

Select the filter you wish to use; in this case, Domain Blocking
was chosen.

Select Disabled to disable Domain Blocking

Allows users to access all domains except Blocked Domains
Denies users access to all domains except Permitted Domains

Enter the Permitted Domains in this field

Enter the Blocked Domains in this field
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Using the Configuration Menu (continued)

Advanced > Firewall

‘Virtual Server

—

Applications

g o d
Filters

UEd-

Firewall

DMZ

Performance

[

AirXpert AE

Tri-Mode Dualband Wireless Router

[ Home FTUTVIR Tools  Status  Help
Fire ul

Firewall Rules can be used to allow or deny trafiic from passing through the D774,

© Enabled © Disabled

Narme ‘
Action O Allow O Deny

Interface  IP Range Start  IP Range End  Protocol  Port Range
sarce [~ ] u |
Destination "‘ V” H ”TCP VH ‘ ‘:l
Schedule O Always

O From nme@:@/m“‘_"‘w’m /UD—VH@

day | Sun ¥ |to | Sun ¥
9 OO0
Firewall Rules List Apply Cancel Help
ActionMarme SourceDestination Protocol
Allow Allow to Ping YWaN port WWAN *LAN 192.168.0.1  ICMP 3 ]
Al [0 (92 185D T0EETE) gy 192 158 0.100UDP 8872 45281 (3
Allow ;r;smsgs (192.168.0.100:10120) WAN FLAN 152.166.0 muﬁ:ﬁggum- ®
Deny Default Giox LAMT 1P
Allow Default LAN = IP @

Firewall Rules is an advanced feature used to deny or allow traffic from passing
through the DI-774. It works in the same way as IP Filters with additional settings.
You can create more detailed access rules for the DI-774. When virtual services are
created and enabled, it will also display in Firewall Rules. Firewall Rules contains all
network firewall rules pertaining to IP (Internet Protocol).

In the Firewall Rules List at the bottom of the screen, the priorities of the rules are
from top (highest priority) to bottom (lowest priority.)

Note: The DI-774 MAC Address filtering rules have precedence over the Firewall

Rules.
Firewall Rules-

Name-

Action-

Source-

Destination-

Schedule-

Enable or disable the Firewall Rules

Enter a name for the rule

Allow or deny IP traffic through the router

Enter the IP Address range

Enter the IP Address range; the Protocol;
and the Port Range

Select Always or enter the Time.
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Using the Configuration Menu (continued)

Advanced > DMZ

D-Link

Building Networks for People

AirXpert, A@

Tri-Mode Dualband Wireless Router

[ Home BT IR Tools Status__ Help

DMZ
DOMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to
the Internet.

DI-774 |

il
i
el
i
DMZ
]

Virtual Server
O Enabled ® Disabled

P Address 192 168.0.[0 |
Applications

™Fitters Y OO

Apply Cancel Help

" Firewall

Performance

If you have a client PC that cannot run Internet applications properly from behind the
DI-774, then you can set the client up to unrestricted Internet access. It allows a
computer to be exposed to the Internet. This feature is useful for gaming purposes.
Enter the IP Address of the internal computer that will be the DMZ host. Adding a
client to the DMZ (Demilitarized Zone) may expose your local network to a variety of
security risks, so only use this option as a last resort.

DMZ- Enable or disable the DMZ. The DMZ (Demilitarized Zone)
allows a single computer to be exposed to the Internet.
IP Address- Enter the IP Address of the computer to be in the DMZ
30
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Using the Configuration Menu (continued)

Wireless
Performance-
Select 802.11a or
802.11g. Here,
802.11a has been
chosen. This screen
displays the wireless
performance features
of the Access Point
portion of the DI-774.

Data Rate-

Auto is the default se-
lection. Select from the
drop down menu for
your selection.
Transmit Power-

Beacon interval-

RTS Threshold-

Fragmentation-

DTIM interval-

Authentication-

Open System -

Shared Key -

SSID Broadcast-

Advanced > Performance > 802.11a

msec, rangs: 0-1000, defaull. 100)
~2345, defeul 2345)

{rangs: 1255, dafault: 1)
Opan System O Sharad sy
881, (3 Enabled © Disabled

Full is the default selection. Select from the drop down menu for
your selection.

Beacons are packets sent by the DI-774 to synchronize a wire-
less network. Specify a value. 100 is the default setting and is
recommended.

This value should remain at its default setting of 2346. If incon-
sistent data flow is a problem, only a minor modification should
be made.

This value should also remain at its default setting of 2346. If you
experience a high packet error rate, you may slightly increase
your Fragmentation value within the range of 256-2346. Setting
the Fragmentation value too low may result in poor performance.

(Delivery Traffic Indication Message) 1 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Open system or Shared Key

The DI-774 will be visible to all devices on the network. This is
the default setting

In this mode, in order to access the DI-774 on the network, the
device must be listed in the MAC Address Control List

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.
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Using the Configuration Menu (continued)

Wireless
Performance-

Select 802.11a or
802.11g. 802.11g is
selected here. Dis-
played in this window
are the Wireless Per-
formance features for
the Access Point por-
tion of the DI-774.

TX Rates-

Auto is the default
selection. Select
from the drop down

Advanced > Performance > 802.11g

ntation - PME | (range: 255~345_ daluslt T8, men numbes ony)

frange: 1~255, defaul 1)
d Key

B02.11g Ondy Mode - © Enable

menu for your selection.

Transmit Power-

Beacon interval-

RTS Threshold-

Fragmentation-

DTIM interval-

Authentication-

Open System -
Shared Key -

SSID Broadcast-

Full is the default selection. Select from the drop down menu for
your selection.

Beacons are packets sent by the DI-774 to synchronize a wire-
less network. Specify a value. 100 is the default setting and is
recommended.

This value should remain atits default setting of 2346. If incon-
sistent data flow is a problem, only a minor modification should
be made.

This value should also remain at its default setting of 2346. If you
experience a high packet error rate, you may slightly increase
your Fragmentation value within the range of 256-2346. Setting
the Fragmentation value too low may result in poor performance.

(Delivery Traffic Indication Message) 1 is the default setting. A
DTIM is a countdown informing clients of the next window for
listening to broadcast and multicast messages.

Select Open system or Shared Key

The DI-774 will be visible to all devices on the network. This is
the default setting

In this mode, in order to access the DI-774 on the network, the
device must be listed in the MAC Address Control List

Choose Enabled to broadcast the SSID across the network.
All devices on a network must share the same SSID (Service
Set Identifier) to establish communication. Choose Disabled
if you do not wish to broadcast the SSID over the network.
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Using the Configuration Menu (continued)
Advanced > Performance > 802.11g (continued)

CTS Mode-

802.11g only mode-

Administrator
Login Name-

user (lower case) is the default login
name for the user account. The user ac-
count has read-only access to the router.

User
Login Name-
admin (lower case) is

name for the admin account. The admin
account has read/write access to the

router.

Admin Password-

User Password-

CTS (Clear To Send) is a function used to minimize collisions
among wireless devices on a wireless local area network (LAN).
CTS will make sure the wireless network is clear before a wire-
less client attempts to send wireless data. Enabling CTS will
add overhead and may lower wireless throughput.

None-  CTSistypically usedinapure 802.11g environment.
If CTS is set to “None” in a mixed mode environment
populated by 802.11b clients, wireless collisions may
occur frequently.

Always- CTS will always be used to make sure the wireless

LAN is clear before sending data.

CTS will monitor the wireless network and automati-
cally decide whether to implement CTS based on
the amount of traffic and collisions that occurs on
the wireless network.

Select this mode to restrict your network to only those devices
that employ the 802.11g standard. Enabling this mode will en-
sure that you maintain the highest connectivity rate, unhampered
by any connection to an 802.11b device.

Auto-

Tools>Admin

‘ N Home _ AdvoncedBi (VSR Status  Help |
I Admin | At (98 Lo Nt "o
Frmware
the default login [ 290
Apply Coneel Help

The default setting is blank - no password. To change the pass-
word, enter and confirm the new password.

The default setting is blank - no password. To change the pass-
word, enter and confirm the new password. 33
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Using the Configuration Menu (continued)

Tools> Admin (continued)

Remote Management

Remote Management allows the DI-774 to be configured from the Internet by a web
browser. A username and password is still required to access the Web-Management
interface. In general, only a member of your network can browse the built-in web pages
to perform “Administrator” tasks. This feature enables you to perform “Administrator”
tasks from the remote (Internet) host.

IP Address: Internet IP Address of the computer that has access to the Router. It is not
recommended that you set the IP Address to * (star), because this allows any Internet
IP Address to access the Router, which could resultin a loss of security for your network.
If you elect to enable Remote Management, make sure to enter the IP Address of the
remote computer allowed to configure the DI-774.

Port: For security purposes, select a separate port number used to access the Router.
(The following is an example only; you may use a different port number.)

Example: http://x.x.x.x:8080 where x.x.x.x is the WAN IP Address of the Router and

8080 is the port used for the Web-Management interface.

Tools > Time

ink AirXpert, AG

Tri-Mode Dualband Wireless Router

[__Home _ Advancedi (VS Status___Help |

-
Time

Set the DI-774 system time

Local Time Apri01/2002 00:17:53

Tirme Zone ‘ (GMT-08:00) Pacific Time (US & Canada) b
Time
Default NTP Server (cptional)
System Sethe e year 2002 %] Mo [ Aer_¥] pay [01 ¥]
Hour 00 % Minute | 17 %] Gecand &3 "l
' Firmware
Daylight Saving © Enabled @ Disabled
— start [Jan ][00 ] g [Jen w][01 ]
o '\ o
Cable Test d
Apply Cancel Help

Time settings- In this window you can choose the time zone; set the time;
and enable or disable Daylight Savings Time.

Default

NTP Server- NTP is short for Network Time Protocol. NTP synchronizes com-

puter clock times in a network of computers.
This field is optional.
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Using the Configuration Menu (continued)

Tools > System

D-Link

Building Metworks for Peaple

Air Xpert AG,

Tri-Mode Dualband Wireless Router

[_Home __ Advanced CVTRR Status__Help |

-

DI-774 l

=l
| e |
=
==l
=

System Settings

Save Settings To Local Hard Drive

Admin

Time ) :
Load Settings From Local Hard Drive

| |[ Browse... |

Firmware
Restore To Factory Default Settings
Misc. o

Help
Cable Test

System Settings

Save Settings to
Local Hard Drive- Click Save to save the current settings to the local Hard Drive

Load Settings from
Local Hard Drive- Click Browse to find the settings, then click Load

Restore to Factory
Default Settings-  Click Restore to restore the factory default settings
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Using the Configuration Menu (continued)

Tools > Firmware

D-Link AirXpert A

Tri-Mode Dualband Wireless Router

DI-774 I _
Home _ AdvancedfilE (VTR Status _ Help |
-
"’/ Firmware Upgrade
e ———— There may be new firmware for your DI-774 to improve functionality and performance.
Admin Click here to check for an upgrade on our support site.
To upgrade the firmware, locate the upgrade file on the local hard drive with the Browse
buttan. Once you have found the file to be used, click the Apply button below to star the
| Time firmware upgrade,
Current Firmware Version: 0.01
Firmware Date: Tue, 18 Mar 2003
(T

Flrmwa_re a 6‘3 0

Apply Cancel Help

Firmware

Upgrade- Click on the link in this screen to find out if there is an updated
firmware; if so, download the new firmware to your hard drive.

Browse- After you have downloaded the new firmware, click Browse in

this window to locate the firmware update on your hard drive.
Click Apply to complete the firmware upgrade.
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Using the Configuration Menu (continued)

Ping Test-

Restart Device-

Block WAN Ping-

Discard Ping

from WAN side-

VPN

Pass Through-

DDNS-

Tools > Misc

DDNS-
Dynamic
Domain Name
System is a
method to
keep domain
names linked
to changing IP
Addresses. In
this way,
changing IP
Addresses
(e.g.,via
DHCP) will not
interfere with
network
connectivity.

The Ping Test is used to send Ping packets to test if a computer
is on the Internet. Enter the IP Address that you wish to Ping,
and click Ping

Click Reboot to restart the DI-774

If you choose to block WAN Ping, the WAN IP Address of the DI-
774 will not respond to pings. Blocking the Ping may provide
some extra security from hackers.

Click Enabled to block the WAN ping

The DI-774 supports VPN (Virtual Private Network) pass-through
for both PPTP (Point-to-Point Tunneling Protocol) and IPSec
(IP Security). Once VPN pass-through is enabled, there is no
need to open up virtual services. Multiple VPN connections can
be made through the DI-774. This is useful when you have many
VPN clients on the LAN network.

PPTP- select Enabled or Disabled
IPSec- select Enabled or Disabled

Fill in the required fields to use the Dynamic Domain Name Ser-
vice (DDNS) feature. 37
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Using the Configuration Menu (continued)

Tools > Cable Test

D-Link

Building Networks for People

AirXpert, AE

Tri-Mode Dualband Wireless Router

(O Status___Help |

|

Cable Test

Ports Link Status
anz T Connected
CR)

%
x
°
=]

Cable Test is an advanced feature that integrates a LAN cable tester on every
Ethernet port on the router. Through the graphical user interface (GUI), Cable Test
can be used to remotely diagnose and report cable faults such as opens, shorts,
swaps, and impedance mismatch. This feature significantly reduces service calls and
returns by allowing users to easily troubleshoot their cable connections.

Ports — The Ethernet port names associated to the physical ports.

Link Status — The current link status of the Ethernet cable connected to the respective
Ethernet port.

More Info — Click on More Info for detailed information about the cable link status.

Refresh — Click on Refresh to run the Cable test. Allow the router a few seconds to
complete the test.
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Using the Configuration Menu (continued)

Status > Device Info
AirXpert A@

Tri-Mode Duclband Wireless Router
DI-774

Flsrwtn Varsion: 0,07, Tue, 18 Mar 2003
[T
MAC A 0011 T2 T4455

P Addewn 190 162011
Subaet Mk 155 255 2581)

DHCP Semvne Enasied

L
MAL Addesss (0112293445
Commuchan [ Giicr Faiass | | DHOF e

P Ao 0000

Subaet Mk 0000

Balih Siatrmny 0009
s

Wewlass 50 119
MAC Addewms. (003261234055
T et
Chanaal |
WEP Disabled

Wirwlens 102 118
MAC Addeawn (010002434 61

B0 et
Chanme! &1 Torka Made: Diabind
WEF Disabied

o
oo

Device Information- This screen displays information about the DI-774

Status > Log

DI-774

=N Home  Advanced  Too siatus  ITEPENNL

Vi Ly dhaplays the activiies occumng an fhe D774, Cick on Log Sattings for sdvanca

[r— featen
[+]
el === (] () e ] o
. pagn 1 ol X
Tirw Mersge SeurceDitaation Moty
AprfO12002 00 2402 Wereless PC coantcted 00-40-05-B7-56-8F
| || A
Apr0 12002 002400 Wireless PC connected 00-40.05-B7-56-8F
AprOUZ02 002358 Wirelens PC connecied 00-40-05-B7-56-8F
ApoO1Z002 0023 54 Wireless PC connected. 00-40.05-B7.56-8F
Ape 0172002 00-23:52 Wireless PC connected 00-40.05-B7.56-8F
Apf012002 00:23:52DHCP Ducover
Aprf0 172002 0023 50 Wireless PC coonected 00-40.05-B7-56-8F
Aprf0172002 00:23 48 Wireless PC connected. 00-40.05-B7.56-8F

ApefI12002 00 2348 DHCE Ducover

View Log- This screen displays the activity on the DI-774

Log Settings- For advanced features, click on Log Settings

39

Download from Www.Somanuals.com. All Manuals Search And Download.



Using the Configuration Menu (continued)

Status > Log > Log Settings
D-Link A if'XPeIth,_r': A@

Building Netwarks for People
Tri-Mode Dualband Wireless Router

‘ Home  Advanced 'Toofs Status m

Log settings

=4
3|
N

Logs can be saved by sending it to an admin email address
Device Info

SMTP Server / P Address | |

|1 g

Email Address [ |[_Send Mail Now
Log Type System Activity
™ stats [ Debug Information
Aftacks
[ Dropped Packets
Wireless Motice
9 9O
Apply Cancel Help
SMTP Server/
IP Address- Enter the proper SMTP Server information or the IP Address
Email Address- Enter the email address of the recipient who will receive the
email logs.
Log Type- The administrator can specify which surveillance they want to

log. Check mark the box for specific activities.

40
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Using the Configuration Menu (continued)

Traffic Statistics-

Connected
Wireless
Client List-

Status > Stats

AirXpert AG

Tri-Mode Dualband Wireless Router

Home  Advanced  Tools SR Help |

Traffic Statistics

Traffic Statistics display Receive and Transmit packets passing through the D774,
o

Help

Receive Transmit

WAN 0 Packets 114 Packets

LAN 4769 Packets 5973 Packets

WIRELESS 11g 94 Packets 1013 Packets

WIRELESS 11a D Packets 1558 Packets

Displays the receive and transmit packets that are passing through
the DI-774. Click on Refresh, for the most recent information.
Click Reset to reset the counters back to zero.

Status > Wireless

D-Link

Building Networks for Peaple

AirXpert, A@

Tri-Mode Dualband Wireless Router

DI-774 l
e Home  Advanced  Tools Status m

‘/ Connected Wireless Client List
The Wireless Client table below displays Wireless clients Connected to the AP o

—

Device Info laecess o) Help

Connected Time MAC Address Mode
April1/2002 00:25:24 00-40-05-B7-56-8F 2.4 GHz

rL— April1£2002 00:23:06 00-90-4B-B0-FD-84 2.4 GHz

f og

Displays the wireless clients that are connected to the Access
Point function of the DI-774. 41
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Using the Configuration Menu (continued)

Help

D-Link AirXpert AG

Tri-Mode Dualband Wireless Router
DI-774 |

Home  Advanced  Tools Status Help
‘«'"’ Home
Setup Wizard

« Wireless Settings
o WAN Settings

Menu

LAN Settings
DHCP Server

Advanced
« Vitual Server
« Special Applications
« Filters

« Firewall Rules

DZ
Wireless Performance

Tools
« Administrator Settings
« System Time
« System Seftings

o Firmware Upgrade
« Miscellaneous ltems

Status
« Device Information
« Log
« Traffic Statistics
« Connected Wireless Client List

FAQs

Help- Displays the complete Help menu. For help at anytime, click
the Help tab in the Configuration menu.
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Networking Basics

Using the Network Setup Wizard in Windows XP

In this section you will learn how to establish a network at home or work, using
Microsoft Windows XP.

Note: Please refer to websites such as http://www.homenethelp.com
and http://www.microsoft.com/windows2000 for information about networking
computers using Windows 2000, ME or 98.

Go to Start>Control Panel>Network Connections
Select Set up a home or small office network

Mebwork Setup Wizarnd

Welcome to the Network Setup
Wizard

Thiz wizard will help pou set up this computer (o un on your
network. With a network, pou can:

Share an Internet connection

Set up Internet Connection Firewall
Share files and folders

Share a printer

LI I

To continue, click Mest.

I Cancel

When this screen appears, Click Next.
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Networking Basics

Please follow all the instructions in this window:

Network Setup Wizand

Before you continue.__

Before you continue, review the Shecklist for creating a netwark.

Then, complete the following steps:

+ Inztall the network cards, moderns, and cables.

+ Turn on all computers, printerz, and external modems.
+ Connect to the Intermet.

“When pou click Mest, the wizard will zearch for a shared Intemet connection on your network,

Click Next

In the following window, select the best description of your computer. If your
computer connects to the internet through a gateway/router, select the second option
as shown.

Network Setup Wizard

Select a connection method.

Select the statement that best describes this computer:

() Thiz computer connects directly to the Intemet. The other computers on my network connect
to the Internet through this computer,

Wiew an example.

@gThis computer connects to the [ntemet through another computer on my network. or through
a.lesidential oateway,
Wigw an example.

S S S =

() Other

Learn miore about hame or small affice netwaork. confiqurations.

r—

< Back I Mewt > ' Cancel

Click Next
44
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Networking Basics

Enter a Computer description and a Computer name (optional.)

Network Setup Wizard
Give this computer a description and name.

[Qomputer descrphion: | Mary's Computer

e

Examples: Family Room Computer or Monica's Computer

[ Computer namme: | Office ]
Evarnples. FAMILT of MONICE

The current computer name iz Office

Learn more about computer names and descriptions.

< Back l Mext = ' Cancel

Click Next

Enter a Workgroup name. All computers on your network should have the same
Workgroup name.

Network Setup Wizard

Mame your network.

Mame your netwark, by specifving a workgroup hame belaw. All computers on pour network,
should hawve the same work group name.

“Workgroup name: | Accounting

Esamples, HOME of OFFICE

< Back Mext » Cancel

Click Next
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Networking Basics

Please wait while the Network Setup Wizard applies the changes.

Network Setup Wizard

Ready to apply network sethings. .

The wizard will apply the following settings. This pracess may take a few minutes to complate
and cannot be interupted.

Settings:
Metwork settings: ~
Computer description: Mary's Computer
Computer name: Office
‘wiorkgroup name: Accounting
The Shared Documents folder and any printers connected to this computer have been
shared.
»

To apply theze settings, click Mest.

’ < Back ﬂ Mest » i[ Cancel
\

When the changes are complete, click Next.

Please wait while the Network Setup Wizard configures the computer.
This may take a few minutes.

Hetwork Setup Wizand

Please wait._.

Pleaze wait while the wizard configures thiz computer for home or small office netwaorking. T his
process may take a few minutes.

ey
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Networking Basics

In the window below, select the option that fits your needs. In this example, Create a
Network Setup Disk has been selected. You will run this disk on each of the

computers on your network. Click Next.

Network Setup Wizand

You're almost done...

®  You need to run the Metwark Setup wizard once on each of the computers on your
‘E’) network. To run the wizard on computers that are not running *Windows P, you can use
the Windows #P CD or a Metwork Setup Digk,

“w'hat do you want to da?

() Use the Netwark Setup Disk | alieady have
(01 Use my Windaws XF CD

(2 Just finish the wizard; | don't need ta run the wizard on other computers

(=T

Insert a disk into the Floppy Disk drive, in this case drive A.

Network Setup Wizand

Insernt the dizk you want to use.

Inzert a disk the inta the follawing disk drive, and then click Mest.
3% Floppy [&:]

If you watt to format the disk, click Format Disk.

47
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Networking Basics

%]

Copying...

L -/

Please wait while the wizard copies files, ..

[ ) Zancel |

Please read the information under Here’s how in the screen below. After you com-
plete the Network Setup Wizard you will use the Network Setup Disk to run the
Network Setup Wizard once on each of the computers on your network. To continue
click Next.

Mebwork Setup Wizand

To run the wizard with the Network Setup Disk_.. %

® . Complete the wizard and restart this computer. Then, uze the Metwork Setup Dizk torun
‘11) the Metwaork Setup Wizard once on each of the other camputers an paur netwark.

Here's how:
1. Inzert the Metwork Setup Dizk into the nest computer you want to network,

2. Open My Computer and then open the Metwork Setup Dizk.
3. Double-chick "netzetup "

48
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Networking Basics

Please read the information on this screen, then click Finish to complete the
Network Setup Wizard.

Hetwork Setup Wizand

Completing the Network Setup
Wizard

You have successfully et up this computer for home or zmall
office networking.

For help with home or zmall office nebworking, zee the
fallowing topics in Help and Support Center:

+ Uszing the Shared Documents folder
+ Sharing filez and folders

To zee other computers an your nebwark, click Start, and then
click ky Metwark Places.

To cloze thiz wizard, click Finizh.

| <Back Firish |

The new settings will take effect when you restart the computer. Click Yes to restart
the computer.

System Settings Change X

P You must reskark your computer before the new settings will take effect.
-
T

Do wou want to restark your computer now?

I oves | [ Mo

You have completed configuring this computer. Next, you will need to run the Network
Setup Disk on all the other computers on your network. After running the Network

Setup Disk on all your computers, your new wireless network will be ready to use.

49
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Networking Basics
Naming your Computer

To name your computer, please follow these directions:In Windows XP:

m Click Start (in the lower left corner of the screen)

m Right-click on My Computer

m Select Properties and click

_\ Internet
g Internet Explorer
w5 E-mail

A Outlook Express

(XN _Crmand Prompk

ﬂ M3M Explorer

c.‘) wWindows Media Player
@ Windows Movie Maker
@ Tour \Windows ¥P

? Files and Settings Transfer
- “Wizard

_-_] My Documents
4} My Recent Documents »

_:E} My Pictures
]

-} My Music
y My Computer |
Open

‘} My Network  Explore
| Search...
Bﬂ Control Panel  Manage
Map Metwork Drive. ..

a Connect Ta
=1

j_\.‘_;é Printers and F

Disconnect Metwark Drive, ..

Show on Desktop
Rename

B Select the Computer
Name Tab in the System
Properties window.

B You may

enter a Com-

puter Description if you
wish; this field is optional.

m Torename the computer
and join a domain, Click

Change.

System Properties

.I.:-Eémote
Advanced

tlc Ulpciates

1 Ge:neral = EomputerName T

D

Computer description:

Hardware

Windows uzes the following information to identify your computer

ot the netwark,

For example; "Fitchen Computer” or "Mary's
Carnputer'.

Full computer name:  Office

Wwharkgroup: Accounting

To uze the Metwork, |dentification Wizard to join a
domain and create a local user account, click Metwark,

T rename this computer or join a domain, click Change.

50
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Networking Basics
Naming your Computer

B In this window, enter the Computer Name Changes @

Computer name
Yaou can change the name and the membership of thiz
computer. Changes may affect access to network resources.

B Select Workgroup and enter
the name of the Workgroup Compter e
Offlce
B All computers on your network ; _
ull computer name;
must have the same Office
Workgroup name.

More. .

B Click OK termber of
D_Qomain:

(=) whorkgroup:
| Accounting

o]

Checking the IP Address in Windows XP

The wireless adapter-equipped computers in your network must be in the same IP Ad-
dress range (see Getting Started in this manual for a definition of IP Address Range.) To
check on the IP Address of the adapter, please do the following:

B Right-click on the Disable
Connection icon

in the task bar Repair

Wiew Awailable Wireless Metworks

Cpen Network Connections

B Click on Status

51
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Networking Basics
Checking the IP Address in Windows XP

This window will appear.

General |‘ Support '

Wireless Network Connection 7 Status

[2)

?X]

Internet Pratocal [TCPARF)

| Click the
Su pport tab Addrezs Type: Azzighed by DHCP
| 1Paddess 1921680114 |
Subret Mazk: 255.255.255.0
Default Gateway: 192.168.0.1

Detailz...

[ | Click Close

Cloze

Assigning a Static IP Address in Windows XP/2000

Note: Residential Gateways/Broadband Routers will automatically assign IP Ad-
dresses to the computers on the network, using DHCP (Dynamic Host Configura-
tion Protocol) technology. If you are using a DHCP-capable Gateway/Router you
will not need to assign Static IP Addresses.

If you are not using a DHCP capable Gateway/Router, or you need to assign a Static IP
Address, please follow these instructions:

'..@ Tour Windows 5P
1‘5 Paink

| E’ Control Panel

B Goto Start ;
|.",‘L,'_;| Printers and Faxes

@) Help and Support
‘@ Files and Settings Transfer =
. Wizard
B Double-click on Search
Control Panel
1—) Run..

All Programs D

Compuker
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Assigning a Static IP Address in Windows XP/2000

B Double-click on
Network
Connections

B Right-click on Local Area
Connections

B Double-click on
Properties

B Control Panel

File Edit View Favorites Tools Help

'\:/) 'd L? /"._]Search IL~ Folders -v

Address [} Control Panel

%, Accessibility Options

ﬂ" Contral Panet S < Add Hardware
Q Add or Remove Programs
B- Swikch ko Category Yiew 4 Administrative Tools
Date and Time

See Also

‘ windows Update
@) Help and Support

&= Game Controllers
glntamet Ciptions

Phone and Modem Options
Sy Power Options
aPrinters and Faxes
Q Regional and Language Options
= Scanners and Cameras
Scheduled Tasks
£, Sounds and Audio Devices

fr—
+ g | Stard

* Network Connections

File Edit View Favorites Tools  Advanced  Help

eEa:k L > )

address & Network Connections

$)
- search [ Folders

A Mame

LAN or High-Speed Internet

|5 create anew
connection Disable
% Setup a homs or smal Status
office network Repair
@ Dissble this network
device Bridge Connections
Q, Repair this connection

Network Tasks &

Create Shorkcut

i Rename this cannection
) view status of this
conmetiorn

Change settings of this
connection

Other Places

@ Contral Panel .|
&) My Network Places

(L) My Documents

4 My Camputer

Details

53
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Networking Basics
Assigning a Static IP Address : _
in WindOWS XP/2000 -L liocal Area Connection 7 Properties

General ._ Advanced

Connect using:

B Click on Internet Protocol | B8 DoLink DWL-ABS0

(TCP/IP) (o]

This connection uzes the following items:

B Click Properties 15 Client for Microsaft Metworks

| S File and Printer Sharing for Microzoft Networks
= 305 Packet Scheduler
Intemet Pratacal [TCRAR) I

D escription

| Tranzmizzion Contral Protocaol/|ntermet Pratocol. The default
wide area network, protocol that provides communication
aciogs diverse inkerconnected networks.

[ Show icon in notification area when connected

B Input your IP address and :
subnet mask. (The IP ok J [ Cance
Addresses on your network
must be within the same
range. For example, if one
CompUter has an IP Address Internet Protocol (TCP/IP) Properties

of 192.168.0.2, the other e |
computers should have IP " e
“r'ou can get IP settings assigned automatically if your network. supports
Add]’esses that are this capability. Othenwize, you need to ask your network. administrator for
. . the appropriate P settings.
sequential, like 192.168.0.3
and 192 X 168 04 The (O Obtain an IP address automaticaly
Uze the following P addiess:
subnet mask must be the (Quliz e folovig P ders)
IP address [192 188, 0 . 2 |
same for all the computers —
Subnet mask: | 255 255 .2%5 . 0
on the network. ——
Default gateway: | 192 .168. 0 . 1 _\
B Enter the IP Address
Of th e Defau |t (@ Usze the following DMS server addresses:]
Gateway (|n thIS case Ereferred DMS zerver: | ‘
|t |S 19216801 fOI’ Alternate DMS server:
the DI-774)
Ad d...
B Input your DNS server
address. O

The DNS server address will be supplied by your ISP (Internet Service Provider).
If the DNS Server address is not available from your ISP, you may input 192.168.0.1
in this field.

B Click OK 54
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Networking Basics
Assigning a Static IP Address with Macintosh OSX

an
- & 3
B Go to the Apple Menu and se- mm e @me s o
lect System Preferences bl Bl s O
a8 aD
B Click on Network S
e @ Q ¢
2488 082
'86 MNerwark
B Select Built-in Ethernetinthe ¢ ™ }d@k a
Show pull-down menu
Location:  Automatic "ﬂ
Show: | Built-in Ethernet 1
m Select Manually in the = )
Configure pull-down menu e Wil
Using BootP : __‘_Em!m‘
1P Address

(Provided by DHCP Server)
Subner Mask: 255.255.255.0

Router: 15216801 Search Domains ___ tDodonal

DHCP Cliens 1D
(Opcionaly
Lample: agple.com. sasthlink net
Ethernet Address.

(@) Click the lock 1o prevent further changes.

‘88 Merwark
B Inputthe Static IP Address, « W40 3
the Subnet Mask and the T =
Router IP Address in the o Do s B
appropriate fields RGP poroe | AppieTaik | provies |
Configure: | Manualty i)

B Input the Domain Name = Bontn Nawme Setvers g
Server address. Your ISP
(Internet Service Provider)
will provide the IP address of
the DNS Server. If the DNS
Server address is not avail- Ethernet Address: 00.09.93.75:de-5a
able from your ISP, you may

Subnet Mask:  255.255.255.0

Router  192.168.0.1 Search Domains Oprionall

Example: apnle.com. earthlink.net

|nput 192.168.0.1 |n thIS f|8|d. E‘ Click the lock o prevent further changes. F’.Wu;:

B Click Apply Now
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Networking Basics
Selecting a Dynamic IP Address with Macintosh OSX

an [=)
L Rse 8
B  Go to the Apple Menu and select n = E @B 6 0
System Preferences s
& ® o my
B Click on Network 2@ea =
258 5 812
eec  Newek
« E A4 3
Show AN Dviplays Socund Network  Slartup Owsk
B Select Built-in Ethernet in the cocation: (R »
Show pull-down menu e =
o= = *onies |
= Manually

@I, - Using DHCP

B  Select Using DHCP in the szt Servers gtans

Configure pull-down menu A, et o s

Subnet Mask: 255,255.255.0

Router. 19218801 P sttt bt S L e

DHCP Client 1D
Iptsonal

Example apple.com, eaithlisk net

Ethernet Addresc:

@ Click the Inck to prevent fusther changes.

eo MNerwark
« =A@ 4
Show All Dhaplays Sound Network  Startup Disk
. C“Ck Apply NOW Location: Automatic T‘
Show: | Built-In Ethernet i3]
freee Y preot | AppleTalk | Proxies |
ont re: I5in .
B The IP Address, Subnet contre: (mponey T
y Domain Name Servers iOpsionali
mask, and the Router’s IP e e ===
Address will appear in a few e
seconds R TR Search Doessing_ optonst
DHCP Client 1D: |
IDprianal)
Ethernet Address: 00.06,96,79.de:5a B Mol oot o ns
(@) Click the lock to prevent further changes " Apply Now
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Networking Basics
Checking the Wireless Connection by Pinging in Windows XP and

2000

B GotoStart>Run> BRI r

XP [Uersion 5.1.26001

H Microsoft Windous rs 5
type cmd. A window (iRt st SR e

Similar to th|s one IF:\Documents and Settings\lah4>ping 192.168_8.50
” T [Pinging 192.168.8.58 with 32 hytes of data:
Wi appear' ype Renly £ron 192. }ss 8 -8: hytes-32 time
R Y X a til

ping

XXX XXX XXX XXX, o :
where xxx is the IP "P*"a:ﬂ:fm :’a';i‘ ol i PG il A
Address of the P:\Documents and Settings\lahd>_

Wireless Router or
Access Point. A
good wireless
connection will show
four replies from the
Wireless Router or
Acess Point, as
shown.

Checking the Wireless Connection by Pinging in Windows Me
and 98

B Goto Start > Run % M5-D0S Prompt

> type command.
A window similar to
this will appear.
Type ping

XXX XXX XXX XXX
where xxx is the IP r
Address of the SR
Wireless Router or
Access Point. A
good wireless
connection will
show four replies
from the wireless
router or access
point, as shown.

57
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Troubleshooting

This Chapter provides solutions to problems that can occur during the installation and
operation of the DI-774 Wireless Broadband Router. We cover various aspects of the
network setup, including the network adapters. Please read the following if you are
having problems.

Note: It is recommended that you use an Ethernet connection to
configure the DI-774 Wireless Broadband Router.

1.The computer used to configure the DI-774 cannot access the
Configuration menu.

B Check that the Ethernet LED on the DI-774 is ON. If the LED is not
ON, check that the cable for the Ethernet connection is securely
inserted.

B Checkthat the Ethernet Adapter is working properly. Please see
item 3 (Check that the drivers for the network adapters are
installed properly) in this Troubleshooting section to check that
the drivers are loaded properly.

B Checkthatthe IP Address is in the same range and subnet as the
DI-774. Please see Checking the IP Address in Windows XP in
the Networking Basics section of this manual.

Note: The IP Address of the DI-774is 192.168.0.1. All the computers on the
network must have a unique IP Address in the same range, e.g., 192.168.0.x.
Any computers that have identical IP Addresses will not be visible on the
network. They must all have the same subnet mask, e.g., 255.255.255.0

B Do aPing test to make sure that the DI-774 is responding. Go to
Start>Run>Type Command>Type ping 192.168.0.1. Asuccessful
ping will show four replies.

Note: If you have changed
the default IP Address,
make sure to ping the cor-
rect IP Address assigned
to the DI-774.
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Troubleshooting

2. The wireless client cannot access the Internet in the
Infrastructure mode.

Make sure the wireless client is associated and joined with the correct Access
Point. To check this connection: Right-click on the Local Area Connection icon
in the taskbar> select View Available Wireless Networks. The Connect to
Wireless Network screen will appear. Please make sure you have selected the

correct available network, as shown in the illustrations below.

Connect to Wireless Network EE|

Disable The following network[z] are available. To access a network, select
it from the list, and then click Connect.

Status
Repair

Available networks:

1 alan ~

Wigw Available Wireless Networks dan
Open Network Connections _

i nn e

If you are having difficulty connecting to a netwark, click Advanced.

[ Connect l[ Cancel I

B Check that the IP Address assigned to the wireless adapter is within the
same IP Address range as the access point and gateway. (Since the
DI-774 has an IP Address of 192.168.0.1, wireless adapters must have
an IP Address in the same range, e.g., 192.168.0.x. Each device must
have a unique IP Address; no two devices may have the same IP
Address. The subnet mask must be the same for all the computers on
the network.) To check the IP Address assigned to the wireless adapter,
double-click on the Local Area Connection icon in the taskbar >
select the Support tab and the IP Address will be displayed. (Please
refer to Checking the IP Address in the Networking Basics section of
this manual.)

B Ifitis necessary to assign a Static IP Address to the wireless adapter,
please refer to the appropriate section in Networking Basics. If you are
entering a DNS Server address you must also enter the Default
Gateway Address. (Remember that if you have a DHCP-capable
router, you will not need to assign a Static IP Address. See

Networking Basics: Assigning a Static IP Address.)

59
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Troubleshooting

3. Check that the drivers for the network adapters are

installed properly.
You may be using different network adapters than those illustrated here, but this
procedure will remain the same, regardless of the type of network adapters you are

using.
T’) Windows Media Player I

Open
| Explore

B? Control P Search...

Manage
e Conneck |
)

"é Printers ¢

Map Metwork Drive, .,
Disconnect Metwork Drive. .

| w Show on Deskkop

@ Help and  Rename

All Programs D

ﬁ‘l Log OFf ®|Turn OFF Computer

/4 stant

System Properties L |
B Select the
Hardware | System Restare 1 Automatic Updates IL__ﬁ_emote |
Tab | General | Computer Name ( Hardwaie ) Advanced
Add Hardware ‘wWizard

i The Add Hardware “Wizard helps you install hardware,

Add Hardware Wizard

Device M anager

B Click Device
Manager

The Device Manager lists all the hardware devices installed
on pour computer, Use the Device Manager to change the
properties of any device.

——
[ Ciriver Sianing ] [( Device Manager 3 ]

Hardware Profiles

Hardware profiles provide a way for you to set up and store
different hardware configurations.

[ Hardware Profiles J

[ [1]:8 ][ Cancel J Apply
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Troubleshooting

B Double-click
on Network
Adapters

B Right-click on D-Link
AirPro DWL-A650
Wireless Cardbus
Adapter (In this example,
the DWL-AB50 is used,;
you may be using another
network adapter, but the
procedure will remain the
same.)

B SelectProperties
to check that the
drivers are
installed properly

B Lookunder Device
Status to check that the
device is working

properly

B Click OK

Z Device Manager

LE)X]

File  Action Wiew Help
$8 @ 8 =<

= -%" PMTEST
[+ ﬁ Batteries
1§ Computer

| < Disk drives
] f§ Display adapters
|- i= Floppy disk contrallers
] 5 Floppy disk drives
(=) IDE ATA[ATAPT contrallers
| Keyboards
] '_') WMice and other pointing devices
] E‘, Modems
2 Monitors
=2 Mebwork adapters

R R S e R s S e

)

TN

EERD-Link AirPro DwL-A650 Wireless Cardbus Adapter
o |E PCMCIA adapkers
-  Ports (COM & LPT)
¥ %8 Processors
@, sound, video and game controllers

[+ System devices
[+ Universal Serial Bus controllers

Dillink AirPro DWL-A650 Wireless Cardbus Adapter P...

?x

General IAdvanced. .Settings Driver | Resources

[r-Link AiPro DWL-AE50 Wireless Cardbus Adapter

Device type: Metwork adapters
Marufacturer: D-Link
Location: PCI busz 5, device 0, function 0

Device status

é.This device iz working properly.

|1 you are having problems with this device, click Troubleshoat to
| start the troubleshooter.

Troubleshoot. ..

Device uzage:

;Use this device [enable]_ a v |
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Troubleshooting

4. What variables may cause my wireless products to lose reception?

D-Link products let you access your network from virtually anywhere you want. However,
the positioning of the products within your environment will affect the wireless range.
Please refer to Installation Considerations in the Wireless Basics section of this manual
for further information about the most advantageous placement of your D-Link wireless
products.

5. Why does my wireless connection keep dropping?

B Antenna Orientation- Try different antenna orientations for the DI-774. Try to
keep the antenna at least 6 inches away from the wall or other objects.

B Ifyou are using 2.4GHz cordless phones, X-10 equipment or other home secu-
rity systems, ceiling fans, and lights, your wireless connection will degrade dra-
matically or drop altogether. Try changing the Channel on your Router, Access
Point and Wireless adapter to a different Channel to avoid interference.

B Keep your product away (at least 3-6 feet) from electrical devices that generate
RF noise, like microwaves, Monitors, electric motors, etc.

6. Why can’t | get a wireless connection?

To establish a wireless connection, while enabling Encryption on the DI-774, you must
also enable encryption on the wireless client.

B For802.11a, the Encryption settings are: 64, 128 or 152 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

B For 802.11g, the Encryption settings are: 64, 128, or 152 bit. Make sure that the
encryption bit level is the same on the Router and the Wireless Client.

Make sure that the SSID on the Router and the Wireless Client are exactly the same. If
they are not, wireless connection will not be established. Please note that there are two
separate SSIDs for 802.11a and 802.11g. The default SSID for both 802.11a and 802.119g
is default.
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Troubleshooting

7. Resetting the DI-774 to Factory Default Settings

After you have tried other methods for troubleshooting your network, you may

choose to Reset the DI-774 to the factory default settings. Remember that D-
Link Air Xpert products network together, out of the box, at the factory default

settings.

To hard-reset the D-Link Air Xpert DI-774 to Factory Default Settings, please do the
following:

B Locate the Reset button on the back of the DI-774
B Use a paper clip to press the Reset button

B Hold for about 10 seconds and then release

B After the DI-774 reboots (this may take a few minutes) it will
be reset to the factory Default settings
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Technical Specifications

Standards:
[ ] IEEE 802.11¢g
[ | IEEE 802.11b
[ | IEEE 802.11a
[ | IEEE 802.3 and IEEE 802.3u

VPN Pass Through/Multi-Sessions:

[ ] PPTP
[ | L2TP
| IPSec

Advanced Firewall Features:
[ | Supports NAT with VPN pass-through, for added security
MAC Filtering
IP Filtering
URL Filtering
Domain Blocking
Scheduling

Device Management:
[ | Web-based -Internet Explorer v6 or later; Netscape Navigator
v6 or later; or other Java-enabled browsers
u DHCP Server and Client

Wireless Data Rates* with Automatic Fallback:
54Mbps
48Mbps
36Mbps
24Mbps
18Mbps

12Mbps
11Mbps

9Mbps
6Mbps
5.5Mbps
2Mbps
1Mbps
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Technical Specifications (continued)

Security:
[ | 64-, 128-, 152-WEP
| WPA -Wi-Fi Protected Access (64-, 128, 152-WEP with TKIP,
MIC, IV Expansion, Shared Key Authentication)
[ | Supports Advanced Encryption Standard (AES)

Media Access Control:
[ ] CSMA/CA with ACK

Wireless Frequency Range:
[ | 2.400GHz to 2.500GHz
[ | 5.150GHz to 5.850GHz

Wireless Operating Range:
[ | Indoors: Up to 328 feet (100 meters)

Modulation Technology:
[ | Orthogonal Frequency Division Multiplexing (OFDM)
u Complementary Code Keying (CCK)
u Direct Sequence Spread Spectrum (DSSS)

Receiver Sensitivity:

54Mbps OFDM, 10% PER,-73dBm
48Mbps OFDM, 10% PER,-76dBm
36Mbps OFDM, 10% PER,-82dBm
24Mbps OFDM, 10% PER,-85dBm
18Mbps OFDM, 10% PER,-88dBm

12Mbps OFDM, 10% PER,-89dBm
11Mbps CCK, 8% PER,-91dBm

9Mbps OFDM, 10% PER,-90dBm
6Mbps OFDM, 10% PER,-91dBm
5.5Mbps CCK, 8% PER,-92dBm
2Mbps QPSK, 8% PER,-93dBm
1Mbps BPSK, 8% PER,-94dBm

*Maximum wireless signal rate based on IEEE Standard 802.11a and 802.11g specifications.
Actual data throughput will vary. Network conditions and environmental factors, including
volume of network traffic, building materials and construction, and network overhead lower
actual data throughput rate. 65
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Technical Specifications (continued)

Wireless Transmit Power:
[ ] 15dBm * 2dB

LEDs:

Power

Status

WAN

WLAN (Wireless Connection) - 802.11a, 802.11g
Local Network (Ports 1-4)

External Antenna Type:
[ | Single Non-Detachable Antenna

Operating Temperature:
m 32°F to 131°F (0°C to 55°C)

Humidity:

[ | 95% maximum (non-condensing)
Power Input:

[ | Ext. Power Supply DC 5V, 3.0A

[ | 100-240V~50-60Hz

Safety and Emissions:

[ | FCC
[ ] UL
Dimensions:

[ | L = 7.56 inches (192mm)
u W = 4.65 inches (118mm)
u H =1.22 inches (31mm)

Weight:
[ | 10.8 oz. (0.3kg)

Warranty:
| 3 years
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Frequently Asked Questions

Why can’t | access the web based configuration?

When entering the IP Address of the DI-774 (192.168.0.1), you are not connecting to
the Internet or have to be connected to the Internet. The device has the utility built-in

to a ROM chip in the device itself. Your computer must be on the same IP subnet to

connect to the web-based utility.

To resolve difficulties accessing a web utility, please follow the steps below.

Step 1 Verify physical connectivity by checking for solid link lights on the device. If
you do not get a solid link light, try using a different cable or connect to a different
port on the device if possible. If the computer is turned off, the link light may not be
on.

What type of cable should | be using?

The following connections require a Crossover Cable:
Computer to Computer

Computer to Uplink Port

Computer to Access Point

Computer to Print Server

Computer/XBOX/PS2 to DWL-810
Computer/XBOX/PS2 to DWL-900AP+

Uplink Port to Uplink Port (hub/switch)

Normal Port to Normal Port (hub/switch)

The following connections require a Straight-through Cable:
Computer to Residential Gateway/Router

Computer to Normal Port (hub/switch)

Access Point to Normal Port (hub/switch)

Print Server to Normal Port (hub/switch)

Uplink Port to Normal Port (hub/switch)

Rule of Thumb:
"If there is a link light, the cable is right.”
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

What type of cable should | be using? (continued)

What’s the difference between a crossover cable and a straight-through
cable?

The wiring in crossover and straight-through cables are different. The two types
of cable have different purposes for different
LAN configurations. EIA/TIA 568A/568B

. .. 1 White-Green
define the wiring standards and allow for g ‘(’;_J;..tan o
two different wiring color codes as 1 Blue e
illustrated in the following diagram. g ggig;flue
. . 7 White-Brown
*The wires with colored backgrounds may 8 Brown

have white stripes and may be denoted 5684 CABLE END
that way in diagrams found elsewhere.

1 White-Orange
Il straight-through cable f 5 range
How to tell straight-through cable from 3 White.Green
. 4 Blue
across_overcable. _ 5 WhieBlue
The main way to tell the difference 6 Green
B ¥ White-Brown
between the two cable types is to compare 8 Brown

the wiring order on the ends of the cable. If
the wiring is the same on both sides, it is
straight-through cable. If one side has opposite wiring, it is a crossover cable.

5688 CABLE END

All you need to remember to properly configure the cables is the pinout order of
the two cable ends and the following rules:

A straight-through cable has identical ends

A crossover cable has different ends

It makes no functional difference which standard you follow for straight-through
cable ends, as long as both ends are the same. You can start a crossover cable
with either standard as long as the other end is the other standard. It makes no
functional difference which end is which. The order in which you pin the cable is
important. Using a pattern other than what is specified in the above diagram
could cause connection problems.

When to use a crossover cable and when to use a straight-through cable:
Computer to Computer — Crossover

Computer to an normal port on a Hub/Switch — Straight-through

Computer to an uplink port on a Hub/Switch - Crossover

Hub/Switch uplink port to another Hub/Switch uplink port — Crossover
Hub/Switch uplink port to another Hub/Switch normal port - Straight-through
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 2 Disable any internet security software running on the computer. Software
firewalls like Zone Alarm, Black Ice, Sygate, Norton Personal Firewall, etc. might
block access to the configuration pages. Check the help files included with your
firewall software for more information on disabling or configuring it.

Geneal Secuy | Fivecy| Content | Conections | Prgrns | Advarce ]

Step 3 Configure you internet settings. e —

aliaret Tusted stes  Resticted
Sies

Internet

Go to Start>Settings>Control Panel. Double click O s
the Internet Options Icon. From the Security tab, e
click the button to restore the settings to their T

defaults.

cwesl | i)

Click to the Connection tab and set the dial-
up option to Never Dial a Connection. Click

the LAN Settings button

Nothing should be checked. Click OK

[~ Use aproy server for your LAN (These seltings wil nat apply to
diakup or VPN connec tions)

Settings:

Go to the Advanced tab and click the
button to restore these settings to their

defaults

Click OK. Go to the desktop and close any open
windows
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 Check your IP Address. Your computer must have an IP Address in the same
range as the device you are attempting to configure. Most D-Link devices use the
192.168.0.X range.

How can | find my IP Address in Windows 95, 98, or
ME?

Step 1 Click on Start, then click on Run.

Step 2 The Run Dialogue Box will appear. Type winipcfg in the window as shown
then click OK.
Run

Type the name of a program, folder, or document, and
‘windows will open it for you.

Open: Iwinipcfg j

0k i Cancel | Browse... |

Step 3 The IP Configuration window will appear, displaying your Ethernet
Adapter Information.

M Select your adapter from the drop down menu.

M If you do not see your adapter in the drop down menu, your adapter is
not properly installed.

m IP Configuration M=

~Ethernet Adapter Information

|PPP adapter -

Adapter Addvess [0 irf: DFE-550T>, 107100 Adapter

IP Address 0.0.0.0
Subnet Mask 0.0.0.0
Default Gateway

ak I EEleaze, | Femen |

Release All | Renew Al | HMore Info>> |

Step 4 After selecting your adapter, it will display your IP Address, subnet
mask, and default gateway.
Step 5 Click OK to close the IP Configuration window
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address
in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | find my IP Address in Windows 2000/XP?

Step 1 Click on Start and select Run.

Step 2 Type cmd then click OK.
Run EJ

- Twpe the name of a program, folder, document, or
Internet resource, and Windows will open it For wou,

Open: | crod | |

[ Ol JI Cancel II Browse, .. |

Step 3 From the Command Prompt, enter ipconfig. It will return your IP
Address, subnet mask, and default gateway

WINNT system324CMD.EXE

Microsoft Windows 200@ [Uersion 5.
{C» Copyright 1985-2888 Microsoft

D:~>ipconfig

Windows 2088@ IP Configuration

Ethernet adapter Local Area Connection:
Connection—specific DNS Suffix

IP Address. . . . . . . . . . - : 192.168.8.174
Subnet Mask . @ 255.255.255.8

Default Gateway : 192_168.8.1

Step 4 Type exit to close the command prompt.

71

Download from Www.Somanuals.com. All Manuals Search And Download.




Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

Step 4 (continued) Check your IP Address. Your computer must have an IP Address

in the same range of the device you are attempting to configure. Most D-Link devices
use the 192.168.0.X range.

How can | assign a Static IP Address in Windows XP?

Step 1
Click on Start > Control Panel > Network and Internet Connections >
Network connections.

Step 2 See Step 2 for Windows 2000 and continue from there.

How can | assign a Static IP Address in Windows 20007

Step 1 Right-click on My Network
Places and select Properties.

Curdders (B8 X = |-

I

Step 2 Right-click on the Local Network and Dial-up
Area Connection which represents
your network card and select

D-Link DFE-S30TX PCI Fast Ethernet
Adapter

Properties.

Local Area Connection Properties 2lx|

General |

Carnnect using:
I B§ D-Link DFE-530TX PCI Fast Ethemet Adapter

Camporents checked are used by this connection
Highlight Internet Protocol (TCP/ [ riendrints Sraraior o vk 2]
IP) and click Properties. Ee— | j
Install Uninsial | Fuopaties |

- Description
Transmission Control Frotocol/Antemet Protocol The default
wide area netwark protocol that provides communication
across diverss interconnected netwarks.

[¥ Show icon in taskbar when connected

0K Cancel
72
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows 20007

(continued)

Click Use the following IP Address and
enter an IP Address that is on the same
subnet as the LAN IP Address on your
router. Example: If the router’s LAN IP
Address is 192.168.0.1, make your IP
Address 192.168.0.X where X = 2-99.
Make sure that the number you choose is
not in use on the network.

Set the Default Gateway to be the
same as the LAN IP Address of your
router (192.168.0.1).

Set the Primary DNS to be the same as
the LAN IP Address of your router
(192.168.0.1).

Internet Protocol (TCP/IP) Properties 21|
General
You can get IP settings assigned automatically if wour network. supports
this capability. Dthenwise, you need to ask your netwark administrator for
the appropriate |F settings.
" Obtain an IP address autamatically
—(+ Uze the follawing IP address:
1P address: 192 168. 0 . EG
Subret mazk: 265 255 255 . 0
Default gateway 192 168. 0 1
| Obtain DNS server address automatically
—{* Use the following DNS server addresses———————————————
Preferred DMS server. 192 168. 0 1
Altemate DMS server: 4 2 2 2
Cancel

The Secondary DNS is not needed or enter a DNS server from your ISP.

Click OK twice. You may be asked if you want to reboot your computer. Click

Yes.

How can | assign a Static IP
Address in Windows 98/Me?

Step 1 From the desktop, right-click on the

Network Neigborhood icon (Win ME - My

Network Places) and select Properties

Highlight TCP/IP and click the Properties
button. If you have more than 1 adapter,
then there will be a TCP/IP “Binding” for
each adapter. Highlight TCP/IP > (your
network adapter) and then click

Properties.

Network 2] %]

Configuation | |dentfication | Aceess Contil |

The following network components are installed

Client for Microsoft Metworks
D-Link DFE-530T> PCI Fast Etheret Adapter (Fev 4]

Femove | Puopeties |

Add. |

Primary Network Logan:

[ Client for Microsoft Metworks |
File and Print Sharing...
Description
TCPAR is the protocal you use to connect to the Intemet and
wide-area networks
Carcr
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Frequently Asked Questions (continued)

Why can’t | access the web based configuration? (continued)

How can | assign a Static IP Address in Windows

98/Me? (continued)
Step 2 Click Specify an IP Address.

Enter in an IP Address that is on the same
subnet as the LAN IP Address on your router.
Example: If the router’s LAN IP Address is
192.168.0.1, make your IP Address
192.168.0.X where X is between 2-99. Make
sure that the number you choose is not in
use on the network.

Step 3 Click on the Gateway tab.

Enter the LAN IP Address of your router
here (192.168.0.1).

Click Add when finished.

Step 4 Click on the DNS Configuration tab.

Click Enable DNS. Type in a Host (can be
any word). Under DNS server search order,
enter the LAN IP Address of your router
(192.168.0.1). Click Add.

Step 5 Click OK twice.

When prompted to reboot your computer,
click Yes.

After you reboot, the computer will now have
a static, private IP Address.

Step 5 Access the web management. Open your web
browser and enter the IP Address of your D-Link device in
the address bar. This should open the login page for the web

TCP/IP Properties

Advances d MelBIOS |
jon IP Addizss

ask
your and then type itin
the 5

" Dbtain an IP address automaticaly

{5 Specity an P addresst

IF Address: 192.168. 0 .10
Subnet Mask:  [255.255.255. 0

Advenced | NeBiOS |
Gateway | WINS Configuation | IP Address

e Irstalled Gateway st will be the defaul
list will e the arcler in which thes:

Hew gateway

192.168. 0 . 1 Add

Bindings Advanced | NelBIDS |
DNS Configualion | Gateway | WINS Confiquation | IF Addess

€ Disable DNS

—( Enabls DNS
Host | anything Domain: |
DNS Server Search rder —————
192.168. 0 . 1 Add
Domain Suffix $earch Order —————————
gkl
Lz
oK Caneel

management. Follow instructions to login and complete the configuration.
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?

Dynamic Cable connection
(IEATNT-BI, Cox, Adelphia, Rogers, Roadrunner, Charter, and Comcast).

Note: Please configure the router with the computer that was last connected directly
to the cable modem.

Step 1 Log into the web based configuration by typing in the IP Address of the router
(default:192.168.0.1) in your web browser. The username is admin (all lowercase) and

the password is blank (nothing). [Enter retwork Password S 20 x|
fjg; Flease tpps pour wer name and passwaord

Step 2 Click the Home tab and click the Yo 15216301

WAN button. Dynamic IP Address is the Ream  Di624

default value, however, if Dynamic IP Address UserName [

is not selected as the WAN type, select Basowoed [

Dynamic IP Address by clicking on the radio ™ Give this passiword in your password Et

button. Click Clone Mac Address. Click on Concel |

Apply and then Continue to save the

changes.

-
D-Link
Building Networks for Peaple

AirXpert, AG;

Tri-Mode Dualband Wireless Router

DI-774 |
. (TR Advanced  Tools Status Help
‘/' WAN Setting
Please select the appropriate option to connect to your ISP,
—
Wizard
@ Dynamic IP Address Choose this option to obtain an [P address automatically
from your ISP. (For most Cable modem users)
T Wireless O Static IP Address Choaose this option to set static IP information provided to
you by your ISP
© PPPoE Choosge this option if your ISP uses PPPoE. (For most
DSL users)
WAN © Others PPTF and BigPand Cable
O PPTP (for Europe use only)
—
LAN
Host Mame |D\-7?4 |(nptmna|j
P — e —
DHCP HATAES: oo J-frv ]-fee |[s3 ][44 ][56 optionan
Clone MAC Address
Primary DNS Address (000 ]
Secondary DNS Address .D 0.0.0 | (optional)
MTU [1500 |
2 00
Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with a Cable modem connection?
(continued)

Step 3 Power cycle the cable modem and router:

Turn the cable modem off (first) . Turn the router off Leave them off for 2 minutes.**
Turn the cable modem on (first). Wait until you get a solid cable light on the cable
modem. Turn the router on. Wait 30 seconds.

** |f you have a Motorola (Surf Board) modem, leave off for at least 5 minutes.

Step 4 Follow step 1 again and log back into the web configuration. Click the Status
tab and click the Device Info button. If you do not already have a public IP Address

under the WAN heading, click on the DHCP Renew and Continue buttons.

Static Cable Connection
Step 1 Log into the web based configuration by

. 2
typing in the IP Address of the router P o
(default:192.168.0.1) in your web browser. The (g Se 1o

username is admin (all lowercase) and the password Ream  DiE2d
. - bane [0
is blank (nothing). o -

I Save tis password in your passward it

Step 2 Click the Home tab and click the WAN Caesl_|
button. Select Static IP Address and enter your static
settings obtained from the ISP in

the fields provided.
D-Link “Aj
. ATing NEw o Teo e Y/ad x e,'t_ B
If you do not know your settings, v S "A.(.:’.
you must contact your ISP. °";| ‘ tome [TTTIETT &S BT
—

Please select the appropriate option to connect to your ISP,
Wizard
- © Dynaric IP Address ouse this opl
o
seal oase this o
@ Static IP Address

O PPPoE

Step 3 Click on Apply and then

. . WAN ] © Others PPTP and BigPond Cable
click Continue to save the o rep (i Eurae use ont)
changes. LN
g 1P Address (0000 (aseigned by your IsP)
. DHCP Subnet Mask [| 0 EI D,

Step 4 Click the Status tab and - P Gy pderess 0000 |
click the Device Info button. Your ot M =—

. . . econdars ress | (optional
IP Address information will be o Ea
displayed under the WAN heading. 9 OO0

Apply Cancel Help
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection?

Make sure you disable or uninstall any PPPoE software such as WinPoet or Enternet
300 from your computer or you will not be able to connect to the Internet.

Step 1 Upgrade Firmware if needed.

(Please visit the D-Link tech support website at: http://support.dlink.com for the latest
firmware upgrade information.)

Step 2 Take a paperclip and perform a hard reset. With the unit on, use a paperclip
and hold down the reset button on the back of the unit for 10 seconds. Release it and
the router will recycle, the lights will blink, and then stabilize.

Step 3 After the router stabilizes, open your browser and enter 192.168.0.1 into the
address window and hit the Enter key. When the password dialog box appears, enter
the username admin and leave the password blank. Click OK.

If the password dialog box does not come up repeat Step 2.
Note: Do not run Wizard.
Step 4 Click on the WAN tab on left-hand side of the screen. Select PPPoE.

Step 5 Select Dynamic PPPoE (unless your ISP supplied you with a static IP
Address).

Step 6 Inthe username field enter ELN/username@earthlink.net and your
password, where username is your own username.

For SBC Global users, enter username@sbcglobal.net.
For Ameritech users, enter username@ameritech.net.
For BellSouth users, enter username@bellsouth.net.

For Mindspring users, enter username@mindspring.com.
For most other ISPs, enter username.

Step 7 Maximum Idle Time should be set to zero. Set MTU to 1492, unless
specified by your ISP, and set Autoreconnect to Enabled.

Note: If you experience problems accessing certain websites and/or email issues,
please set the MTU to a lower number such as 1472, 1452, etc. Contact your ISP for
more information and the proper MTU setting for your connection.
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Frequently Asked Questions (continued)

How can | setup my router to work with Earthlink DSL or any PPPoE
connection? (continued)

Step 8 Click Apply. When prompted, click Continue. Once the screen refreshes,
unplug the power to the D-Link router.

Step 9 Turn off your DSL modem for 2-3 minutes. Turn back on. Once the modem
has established a link to your ISP, plug the power back into the D-Link router. Wait
about 30 seconds and log back into the router.

Step 10 Click on the Status tab in the web configuration where you can view the
device info. Under WAN, click Connect. Click Continue when prompted. You should
now see that the device info will show an IP Address, verifying that the device has
connected to a server and has been assigned an IP Address.

Can | use my D-Link Broadband Router to share my Internet
connection provided by AOL DSL Plus?

In most cases yes. AOL DSL+ may use PPPoE for authentication bypassing the
client software. If this is the case, then our routers will work with this service. Please
contact AOL if you are not sure.

To set up your router:

Step 1 Log into the web-based configuration (192.168.0.1) and configure the WAN
side to use PPPoOE.

Step 2 Enter your screen name followed by @aol.com for the user name. Enter your
AOL password in the password box.

Step 3 You will have to set the MTU to 1400. AOL DSL does not allow for anything
higher than 1400.

Step 4 Apply settings.

Step 5 Recycle the power to the modem for 1 minute and then recycle power to the
router. Allow 1 to 2 minutes to connect.

If you connect to the Internet with a different internet service provider and want to use
the AOL software, you can do that without configuring the router’s firewall settings.
You need to configure the AOL software to connect using TCP/IP.

Go to http://www.aol.com for more specific configuration information of their software.
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Frequently Asked Questions (continued)

How do | open ports on my router?

To allow traffic from the internet to enter your local network, you will need to open up
ports or the router will block the request.

Step 1 Open your web browser

and enter the IP AddreSS Of Yirtual Server is used to allow Internet users access to LAN services.
your D-Link router & Enabled € Disabled
(192.168.0.1). Enter username Narne [pcanywheral Claar
(admin) and your password Private IP 182.168.0.100

(blank by default). Protacal Type  [UDP =]

. Private Port 22
Step 2 Click on Advanced on N

top and then click Virtual Schetue & Aways

Server on the left side. € Fram time [00 7] : [00 =] [t =] 10 [00 7] - [00 =] [amt =]

Step 3 Check Enabled to dey [ B o[ T
activate entry.

Step 4 Enter a name for your virtual server entry.

Step 5 Next to Private IP, enter the IP Address of the computer on your local
network that you want to allow the incoming service to.

Step 6 Choose Protocol Type - either TCP, UDP, or both. If you are not sure, select
both.

Step 7 Enter the port information next to Private Port and Public Port. The private
and public ports are usually the same. The public port is the port seen from the WAN
side, and the private port is the port being used by the application on the computer
within your local network.

Step 8 Enter the Schedule information.
Step 9 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled. If DMZ is enabled, it will disable all Virtual
Server entries.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer
and then open port 81 to the other computer.
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Frequently Asked Questions (continued)

What is DMZ?

Demilitarized Zone:

In computer networks, a DMZ (demilitarized zone) is a computer host or small
network inserted as a neutral zone between a company’s private network and the
outside public network. It prevents outside users from getting direct access to a
server that has company data. (The term comes from the geographic buffer zone that
was set up between North Korea and South Korea following the UN police action in
the early 1950s.) ADMZ is an optional and more secure approach to a firewall and
effectively acts as a proxy server as well.

In a typical DMZ configuration for a small company, a separate computer (or host in
network terms) receives requests from users within the private network for access to
Web sites or other companies accessible on the public network. The DMZ host then
initiates sessions for these requests on the public network. However, the DMZ host is
not able to initiate a session back into the private network. It can only forward packets
that have already been requested.

Users of the public network outside the company can access only the DMZ host. The
DMZ may typically also have the company’s Web pages so these could be served to
the outside world. However, the DMZ provides access to no other company data. In
the event that an outside user penetrated the DMZ hosts security, the Web pages
might be corrupted but no other company information would be exposed. D-Link, a
leading maker of routers, is one company that sells products designed for setting up

aDbMZ

How do | configure the DMZ Host?

The DMZ feature allows you to forward all incoming ports to one computer on the local
network. The DMZ, or Demilitarized Zone, will allow the specified computer to be
exposed to the Internet. DMZ is useful when a certain application or game does not
work through the firewall. The computer that is configured for DMZ will be completely
vulnerable on the Internet, so it is suggested that you try opening ports from the
Virtual Server or Firewall settings before using DMZ.

Step 1 Find the IP address of the computer you want to use as the DMZ host.

To find out how to locate the IP Address of the computer in Windows XP/2000/ME/9x
or Macintosh operating systems please refer to Step 4 of the first question in this
section (Frequently Asked Questions).
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Frequently Asked Questions (continued)

How do | configure the DMZ Host? (continued)

Step 2 Log into the web based
configuration of the router by typing in the IP
Address of the router (default:192.168.0.1) in
your web browser. The username is admin
(all lowercase) and the password is blank

(nothing)

Step 3 Click the Advanced tab and then
click on the DMZ button. Select Enable and

type in the IP Address you found in step 1.

Step 4 Click Apply
and then Continue
to save the changes.

Note: When DMZ is
enabled, Virtual
Server settings will
still be effective.
Remember, you
cannot forward the
same port to multiple
IP Addresses, so the
Virtual Server
settings will take
priority over DMZ

settings.

D-Link

Building Networks for Peaple

DI-774 |

.
=

“Virtual Server

Applications

Filters

Firewall

Performance

[ Home ISR Tools

=

\

i

Access Point
User name: '8 admin ¥

Password:

[CIremember my password

[ K l [ Caniel

Air Xpert, AE

Tri-Mode Dualband Wireless Router

Status Help

DMZ

DMZ (Demilitarized Zone) is used to allow a single computer on the LAN to be exposed to

the Intermet

IP Address

© Enabled & Disabled
192.188.0. [0 |

2 90

Apply Cancel Help
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Frequently Asked Questions (continued)

How do | open a range of ports on my router using Firewall rules?

Step 1 Access the router’s web configuration by entering the router’s IP Address in
your web browser. The default IP Address is 192.168.0.1. Login using your password.
The default username is “admin” and the password is blank.

If you are having difficulty accessing web management, please see the first question
in this section.
Step 2 From the web management Home page, click the Advanced tab then click

the Firewall button.
Step 3 Click on H:&'H‘h

Enabled and type in

AirXpert, AG

Tri-Mode Dualband Wireless Router

aname for the new D77

rule l S Home QWVVITTEN Tools  Status  Help

Step 4 ChOOSe WAN Fm;-w:al\:ﬂulaa can be used to allow or deny traffic fram passing through the DI-774

as the Source and - © Enabled © Dlsabla]d =

enter a range of IP St A

Addresses out on the . Interface H\P Range Start ”IF‘ Range End ‘Pmta:ol Port Range

. — urce v -

Internet that you Destination ‘* v Il jTce bl -l

would like this rule Schedue O Aways ) -

applied to. If you I Firewall O Fram hme‘}ﬁ?‘;ﬁ@;h:Mgm[Eli (00 ] (At ]

would like this rule to day[5un_¥]1o[5um ]

. T omz (v
allow all internet i 9 00
F ] s Apply Cancel Help

users to be able to ActionName SourceDestination Pratocol -

access these pOI’tS, Performance Allowr ﬁILﬁStJSi;E%%'AﬂNUTD% a5 WAN.*LANJBZ 168.0.1 ICMP B ] ._'}
. Allow 152 WYAN TLAN 192 168.0.100UDP B572-45281 !_/}

then ‘)ut an ASterIS k msmsgs (192.168.0.100:10120) 5 TCP0120-

. . Allow 17 WAN TLAN 192 168.0 1DD17539 !ﬁ

in the first box and iy B o e i

leave the second box Miow Defaul L o [

empty.

Step 5 Select LAN as the Destination and enter the IP Address of the computer on
your local network that you want to allow the incoming service to. This will not work

with a range of IP Addresses.

Step 6 Enter the port or range of ports that are required to be open for the incoming
service.

Step 7 Click Apply and then click Continue.

Note: Make sure DMZ host is disabled.

Because our routers use NAT (Network Address Translation), you can only open a
specific port to one computer at a time. For example: If you have 2 web servers on
your network, you cannot open port 80 to both computers. You will need to configure
1 of the web servers to use port 81. Now you can open port 80 to the first computer

and then open port 81 to the other computer. 82
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Frequently Asked Questions (continued)

What are virtual servers?

A Virtual Server is defined as a service port, and all requests to this port will be
redirected to the computer specified by the server IP. For example, if you have an FTP
Server (port 21) at 192.168.0.5, a Web server (port 80) at 192.168.0.6, and a VPN
server at 192.168.0.7, then you need to specify the following virtual server mapping

table:

21 192.168.0.5 X
80 192.168.0.6 X
1723 192.168.0.7 X

How do | use PC Anywhere with my router?

You will need to open 3 ports in the Virtual Server section of your D-Link router.
Step 1 Open your web browser and enter the IP Address of the router (192.168.0.1).

Step 2 Click on Advanced at the top and then click Virtual Server on the left side.

Step 3 Enter the Virtual Server

information as seen Yirtual Server is used to allow Internet users access to LAN services.
below. The Private IP is & Enabled © Disabled

the IP Address of the Marne [peamawheret Clear |

computer on your local Private IP [13z 1680100
network that you want to Protocol Type [UDP =]

connect to. Prvate o[22
Public Port 22
Step 4 The first entry Schedule & Always
will read as shown here: € From time [00 =] - [o0 =] [am =] 1o [0 =] : o0 =] [am =]
day [Sun =] to[Sun =]

Step 5 Click Apply
and then click Continue.
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Frequently Asked Questions (continued)

How do | use PC Anywhere with my router? (continued)

Step 6 Create
a second entry

as shown here:

Step 7 Click
Apply and then

click Continue.

Step 8 Create
a third and final
entry as shown

here:

Wirtual Server is used to allow Internet users access to LAN services.

% Enahled © Disabled

Mame |pcanywher82 Clear |
Private |P |1 52.168.0.100

Protocal Type ITCP 'l
Private Port |5531
Public Port I5831

Schedule & Always

 From timelﬂuj:|DDﬂIAMﬂtD|UDﬂ:|DDﬂIAMﬂ

day ISun 'l mISun 'I

Yirtual Server is used to allow Intermet users access to LAN services.

& Enabled © Disahled

harne IpcanwhereS Clear |
Private P |192.1EB.D.1DD

Protocal Type IUDP 'l
Private Part |5832
Public Paort |5632

Schedule & Always

© From time |00 x) - [00 = |AM =] to |00 =] - [00 =] |AM =]

day ISun 'l to ISun 'l

Step 9 Click Apply and then click Continue.

Step 10 Run PCAnywhere from the remote site and use the WAN IP Address of the
router, not your computer’s IP Address.
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Frequently Asked Questions (continued)

How can | use eDonkey behind my D-Link router?

You must open ports on your router to allow incoming traffic while using eDonkey.

eDonkey uses three ports (4 if using CLI):

4661 (TCP) To connect with a server

4662 (TCP) To connect with other clients

4665 (UDP) To communicate with servers other than the one you are connected to.
4663 (TCP) *Used with the command line (CLI) client when it is configured to allow
remote connections. This is the case when using a Graphical Interface (such as the

Java Interface) with the client.

Step 1 Open your web browser and enter the IP Address of your router
(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.

Step 3 Create a new firewall rule:
Click Enabled.
Enter a name
(edonkey).

Click Allow.

Next to Source,
select WAN under

AirXpert AG

Tri-Mode Dualband Wireless Router

H . DI-774
interface. In tlle first l [ Home BWYYCLZNEN Tools Status Help
box, enter an *. Leave ‘/,. ———
the second box Firewall Rules can be used to allow or deny traffic fram passing through the DI-774
empty. MR © Enabled O Disabled
Next to Destination, Name  [edonkey |(Glear]
Applications Action @ Allow O Deny
Se|eCt LAN under Interface  IP Range Stant IP Range End  Protocol  Port Range
interface. Enter the IP Source  waN ][+ | |
Addl’eSS Of the Destination ‘LAN v || 192.168.0.100 | I * 4661 |- | 4665 |
Schedule O Always
computer you are I Firewall © From tims 00 1 (00 %[ 4 ¥ 10 00 ] . [0 ¥ [ vt ]
running eDonkey day[Sn ¥ ta[sun ]
from. Leave the oMz @ 90O
E 11 Rules Apply Cancel Hel
Second bOX empty‘ ] ActionMame SourceDestination grnymcglnc ef
Under Protocol, Allow Allow to Ping WAN port WANTLAN,192.168.0.1  ICMP 8 E]
select *. In the pOI’t : Allow T8 (1921630 100:8572)  \yan = and 192 168.0.100UDP B572-45281 [4
range boxes. enter Alow TS [192.168.0.100:10120) WAN,*LAMBNEEDmmﬁ%&mm B
466Lin the first box o Do ot
and then 4665 in the
second box. Click
Always or set a schedule.
Step 4 Click Apply and then Continue. 85
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Frequently Asked Questions (continued)

How do | set up my router for SOCOM on my Playstation 27?

To allow you to play SOCOM and hear audio, you must download the latest firmware
for the router (if needed), enable Game Mode, and open port 6869 to the IP Address of
your Playstation.

Step 1 Upgrade firmware (follow link above).

Step 2 Open your web browser and enter the IP Address of the router (192.168.0.1).
Enter username (admin) and your password (blank by default).

Step 3 Click on the Advanced tab and then click on Virtual Server on the left side.

Step 4 You will now create a new Virtual Server entry. Click Enabled and enter a
name (socom). Enter the IP Address of your Playstation for Private IP.

Step 5 For Protocol Type select Both. Enter 6869 for both the Private Port and
Public Port. Click Always. Click Apply to save changes and then Continue

D-Link

Building Networks for Peaple

AirXpert A@

Tri-Mode Dualband Wireless Router

DI-774 l
X [ Home JFTTUEY I Tools Status Help
Wirtual Server is used to allow Internet users access to LAN senvices
Virtual Server
@ Enabled O Disabled
Narme [ socom |
PRAEP Lz'm&u 100
Protocol Type  Both ¥
Filters Private Fon | 6869 |
Public Pot | 6869 |
T Firewall Schedule @ Always
© From time [00 % \:U“ v [ AM “‘m}_“”_“’d [o0 ] [am v
oMz day[Sun ¥|ta[Sun ¥
Performance a J o
al S s Apply Cancel Help
Name Private [P Protocal Schedule
Virtual Server FTP 0.0.00 TCP 2121 ahways @i
Virtual Server HTTR 0.0.00 TCP B0/0 ahways [E]i]
Virtual Server HTTPS 0.0.00 TCP 4434443 always =
Vitual Server DNS 0.0.00 UDP 53753 abways [Hi
Virtual Server SMTP 0000 TGP 25125 abways @i
Virtual Server POP3 0000 TCP 110410 aways [
Virtual Server Telnet 0000  TCP 2323 aways (A0
IPSec 0.0.00 UDP 5004500 abways [E])
PPTP 0000 TGP 17231723 always @5
Nethleeting 0000  TCPI720/1720  aways 4

Step 6 Click on the Tools tab and then Misc on the left side.

Step 7 Make sure Gaming Mode is Enabled. If not, click Enabled. Click Apply
and then Continue. 36
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Frequently Asked Questions (continued)

How can | use Gamespy behind my D-Link router?

Step 1 Open your web browser
and enter the IP Address of the
router (192.168.0.1). Enter
admin for the username and D774 |
your password (blank by ‘,’j‘

defau It) . Virtual Server is used to allow Intemet users aceess to LAN senices
Virtual Server
@ Enabled O Disabled

Step 2 Click on the Advanced Name  [gamespyl =]
tab and then click Virtual Server Priate P 1921680100 ]

Protocol Type | TCP v

on the left side. FritePon | 3783]

PublicPort (3783 |

Step 3 You will create 2 R @R

© From time [00 %] : [00 (%] [AM %] 1o [00 ] : [00 %] [aM &

entries. M M

Step 4 Click Enabled and enter e | . . . 2 00

Apply Cancel Help

D-Link

Building Netwarks for People

AirXpert, A@;

Tri-Mode Dualband Wireless Router

[ Home MWTYCUTCE Tools Status Help

Name Private I[P Protocal Schedule

Settlngs' Wirtual Sewer FTP 0000 TCP 2121 always E]i]
Wirtual Server HTTP 0000 TCRB0A0 aways [

NAME - Gamespyl Virtual Semer HTTPS 0.000 TCP 4431443 always E{T)

Wirtual Sever DNS 0000 UDP 53/53 always E]i]

Wirtual Sewer SMTP 0000 TCP 25025 always i}

PRIVATE IP - The 1P Wirtual Server POP3 0000 TCP 1107110 aways (47

“irtual Server Telnet 0000 TCP23/23 always (41

Address of your com puter IPSes 0000 UDP 50000 always 4T

. PPTP 0000 TCP 172341723 always [

that yOU are rUnnlng NetMesting 0000  TCP1720M720  always  [4f

Gamespy from.
PROTOCOL TYPE - Both

PRIVATE PORT - 3783
PUBLIC PORT - 3783

SCHEDULE - Always.
Click Apply and then continue
@ Enabled O Disabled

Step 5 Enter 2nd entry: s gamespy2 |G
Click Enabled el Pivael® (1921680100

Protocol Type  Both |

D-Link

Building Networks for People

Air X pe

O2.1
Tri-Mode Dualband Wireless Router

BT Advanced EPTD Status Help

DI-774 |

Wirtual Server is used to allow Internet users access to LAN services

Virtual:

NAME - Gamespyz Filters Private Port }%}
Public Port (6500 |
PRIVATE IP - The IP Firewall Schedie @ Aways

© From time |00 %[00 ] [AM %] 1o [00 %] [00 %] [0

JEE i

Address of your computer
that youare running
Gamespy from. — | 2 90

Apply Cancel Help

Narre Private [P Protocal Schedule

DMZ =0 Egfto ] &)

i

PROTOCOL TYPE - Both Virtual Server FTP 0000 TeP 21221 atvays [0
Vitual Server HTTP 0.000 TGP 80/A0 abways [Hi
Virtual Server HTTPS 0000 TCP 4431443 b [E}i)
PRIVATE PORT - 6500 Nl 0000  UDP5353 :\::ﬁ B
Virtual Server SMTP 0000  TCP2625 aways 400
Virtual Server POP3 0000 TGP 1104110 I [E})
PUBL|C PORT - 6500 v:nﬁ:\sz:zre\m 0.000 TCP 23723 :&:;: 2]
IPSec 0000 UDP 500/500 aways (47

PPTP 0000  TCRI7ZAT23 aways  [4f

SCHEDULE 'AIWayS. MetMeeting 0000 TCP 172011720 abways (B}
Click Apply and then continue. 87
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Frequently Asked Questions (continued)

How do | configure my router for KaZaA and Grokster?

The following is for KaZaA, Grokster, and others using the FastTrack P2P file sharing
system.

In most cases, you do not have to configure anything on the router or on the Kazaa
software. If you are having problems, please follow steps below:

Step 1 Enter the IP Address of your router in a web browser (192.168.0.1).
Step 2 Enter your username (admin) and your password (blank by default).
Step 3 Click on Advanced and then click Virtual Server.

Step 4 Click Enabled and then enter a Name (kazaa for example).

Step 5 Enter the IP Address of the computer you are running KaZaA from in the
Private IP box. Select TCP for the Protocol Type.

Step 6 Enter 1214 in the Private and Public Port boxes. Click Always under
schedule or set a time range. Click Apply.

[ __Home VLN Tools  Status  Help

ki P
mmual > i

Wirual Semver is usad to allow Internet users access to LAN serices

& Enabled © Digabled
Mame |kuzua Claar

Private IP lm
Protocol Type m
Private Port W
Fublic Port W
Schedule & Abways
= From time [00 =] - [00 =] [#0 =] 10|00 =] - [00 =] [am =]
sy [0 =] 1o [Sm =]

Make sure that you did not enable proxy/firewall in the KaZaA software.
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Frequently Asked Questions (continued)

How do | configure my router to play Warcraft 3?

You must open ports on your router to allow incoming traffic while hosting a game in
Warcraft 3. To play a game, you do not have to configure your router.

Warcraft 3 (Battlenet) uses port 6112.

For the DI-604, DI-614+. DI-624, DI-754, DI-764, or DI-774:
Step 1 Open your web browser
and enter the IP Address of your

router (192.168.0.1). Enter
username (admin) and your

(3
-
D-Link
Building Networks for People

A Xpere G

Tri-Mode Dualband Wireless Router

DI-774
password (leave blank). ‘| SN Home BWYUTTIMN Tools  Stotus  Help |
. \/w‘r\ual Server is used to allow Internet users access to LAN services.
Step 2 Click on Advanced I s | ® Ensled O Disaed
. . ame [ |[Clear
and then click Virtual Server. o [ RSN =
Protocol Type - Both |
" Hiters vate Port | 6112 |
Step 3 Create a new entry: ere ]

Schedule

Click Enabled. Enter a name

® Always

Firewall

© From time |00 %[00 ¥/ [AM %15 (00 v [00 ][0 ]

(warcraft3). Private IP - Enter
the IP Address of the computer
you want to host the game.
Select Both for Protocol Type
Enter 6112 for both Private Port
and Public Port Click Always or

day[Sun v]wa[5un ¥

Private IP
0000
00.00
00.00
00.00
0000

Protocal
TCR 2111
TCP 80/80

Marre

Virtual Server FTR
Virtual Server HTTP
Virtual Server HTTPS
Wirtual Server DNS

Virtual Server SMTP TCP 25/25

@ 90

Apply Cancel Help

TCP 443443
UDP 53/53

Schedule
abways
always
always
always
always

[
[E7)
Ef]
]}
B

TCP 110110
TCP 23/23
UDP 500500

Virtual Server POP3
Virtual Server Telnet
IPSec

PPTP

Netieeting

0000
00.00
00.00
0000
0.0.00

always
always
always
always
always

[Ej]
Ey]
]}
[y
[l

set a schedule.

TCP 17231723
TCP 172011720

Step 4 Click Apply and then
Continue.

Note: If you want multiple computers from you LAN to play in the same game that
you are hosting, then repeat the steps above and enter the IP Addresses of the other
computers. You will need to change ports. Computer #2 can use port 6113, computer
#3 can use 6114, and so on.

You will need to change the port information within the Warcraft 3 software for
computers #2 and up.

Configure the Game Port information on each computer:
Start Warcraft 3 on each computer, click Options > Gameplay. Scroll down and you

should see Game Port. Enter the port number as you entered in the above steps.
89
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Frequently Asked Questions (continued)

How do | use NetMeeting with my D-Link router?

Unlike most TCP/IP applications, NetMeeting uses DYNAMIC PORTS instead of
STATIC PORTS. That means that each NetMeeting connection is somewhat different
than the last. For instance, the HTTP web site application uses port 80. NetMeeting
can use any of over 60,000 different ports.

All broadband routers using (only) standard NAT and all internet sharing programs like
Microsoft ICS that use (only) standard NAT will NOT work with NetMeeting or other
h.323 software packages.

The solution is to put the router in DMZ.

Note: Afew hardware manufacturers have taken it on themselves to actually provide
H.323 compatibility. This is not an easy task since the router must search each
incoming packet for signs that it might be a netmeeting packet. This is a whole lot
more work than a router normally does and may actually be a weak point in the
firewall. D-Link is not one of the manufacturers.

To read more on this visit http://www.HomenetHelp.com

How do | set up my router to use iChat? -for Macintosh users-

You must open ports on your router to allow incoming traffic while using iChat.
iChat uses the following ports: 5060 (UDP) 5190 (TCP) File Sharing 16384-16403
(UDP) To video conference with other clients

Step 1 Open your web browser and enter the IP Address of your router

(192.168.0.1). Enter username (admin) and your password (leave blank).

Step 2 Click on Advanced and then click Firewall.
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Frequently Asked Questions (continued)

(continued)

How do | set up my router to use iChat? -for Macintosh users-

Step 3 Create a new
firewall rule:

Click Enabled.
Enter a name
(ichatl).

Click Allow.

Next to Source,
select WAN under
interface.

In the first box,
enter an *.

Leave the second
box empty.

Next to Destination,
select LAN under
interface.

Enter the IP
Address of the
computer you are
running iChat from.

D-Link

Building Networks for People

‘Virtual Server

il
=l
Firewall
DMZ
=

Applications

" Filters

Performance

AirXpert. A@,

Tri-Mode Dualband Wireless Router

[ Home BWY-VUTEE Tools

Status Help

Firewall Rules can be used to allow or deny traffic from passing through the DI-774
@ Enabled O Disabled
Mame |[ichatl | [Clear]
Action @ Allow O Deny
Interface  IP Range Statt 1P Range End  Protocol  Port Range
Source ‘WAN "H ” |
Destination ‘LAN 1921680100 || | UDPVHSOBO <] |
Schedule @ Always
© From tims [00 (9] :[00 ][ 44 %] 10 00 ] [00 ] [t ]
day | Sun ¥ mi?un |
9 00
3
irewall Rules List Apply Cancel Help
Actionhame SourceDestination Protocal
Allowr Allow to Ping WAN port WANTLAN 192168.0.1 ICMP 8 [
Allow T8 (1921680.1008572)  \pa ~1an 192 168 0.10UDR p572-45281 [
Allow MIMSGS (192.168.0.100:10120) WAN*LAN 192 168.0 mDTCPJEHZEI- E]
17 17639
Deny Default *FoOLANT 1P ."
Allow Default LANT =7 (RO

Leave the second box empty. Under Protocol, select UDP. In the port range boxes,
enter 5060 in the first box and leave the second box empty.

Click Always or set a
schedule.

Step 4 Click Apply
and then Continue.

Step 5

Repeat steps 3 and 4
enterichat2 and open
ports 16384-16403

(UDP).

D-Link

Building Networks for Peaple

DI-774

==
=

'Virlual Server

" Filters
rewal
DMZ

Performance

i

Air Xpert AG;

Tri-Mode Dualband Wireless Router

[ Home SWYUNEE Tools

Firewall Rules can be used to allow or deny traffic fram passing through the DI-774

Status Help

@ Enabled O Disabled

Mame [ichat2 |[Ctear |

Action @ Allow © Deny
Interface  IP Range Start IP Range End  Protocol  Port Range
Source  [WAN ¥ I

Destination [LAN ~[102.168.0.100 |

[[UDP¥]iss8s] - oo

Schedule & Always
O From time |00 % - |00 | AM 15|00 | |00 & |AM v
day Sun ~ mﬁn v
2 90O
wall Rules List Apply Cancel Help
ActionMame SourceDestination Protocal
Allow Allow to Fing WAN port WWAN TLAN,192.166.0.1  ICMP 8 ]

msmsgs (192.165.0.100.8572)

Al 152 WAN "LAN, 192, 168.0.100UDP g572-45281 [4

Allow MEMSGS (192.165.0.100:10120) WWAN ~LAN 192 168.0 mDTCFJUWEUV E]
17 17632

Deny Default T LANS P>

Allow Default LAN = »» P@or
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Frequently Asked Questions (continued)

How do | set up my router to use iChat? -for Macintosh users-
(continued)

For File Sharing:
Step 1 Click on Advanced and
then Virtual Server.

D-Link

Building Networks for People

AirXpert, AG

Tri-Mode Dualband Wireless Router

DI-774
Step 2 Check Enabled to | BTN Advanced
activate entry. .- ol Sorvr
Virtual Server is used to allow Intemet users access to LAN senices
@ Enabled O Disabled
Step 3 Enter a name for your - Neme  fichas o)
. . Applications
virtual server entry (ichat3). - praslp  fo21680100 |
Protocol Type | TCP |
Private Port 5190 |
Step 4 Next to Private IP, enter Pubtc Port 5190 |
=Tl Schedule ® Atways
the IP Address of the computer . meymi@\ .l G
on your local network that you [r— oy [Sun ¥1o[5un ]

want to allow the incoming

: oo 9 00

service to. Virtual Servers List Apply cﬁe. Help
Namme Private [P Pratocal Schedule

“irtual Server FTP 0000 TGP 21721 always [E{]

Wirtual Sewver HTTP 0000 TCP 8080 always [Eii]

Step 5 Select TCP for Protocol Vo 0000 Tcpusms w1

Type Wirtual Server DNS 0000 UDF 53/53 aways (47

- Yirtual Server SMTP 0000 TGP 26726 always [0

Wirtual Sewver POP3 0000 TCP 1101110 always [Eii]

Wirtual Sewer Telnst 0000 TCP 2323 always i}

Step 6 Enter 5190 next to IFSec 0000 UDR A0 aways (41

N . PPTP 0000 TCP 172341723 always £ ]

Private Port and Public Port. Netheting 0000 TP aways L3

Step 7 Click Always or
configure a schedule.

Step 8 Click Apply and then Continue.

If using Mac OS X Firewall, you may need to temporarily turn off the firewall in
the Sharing preference pane on both computers.

To use the Mac OS X Firewall, you must open the same ports as in the router:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.

Step 3 Click the Firewall tab.

Step 4 Click New.

Step 5 Choose Other from the Port Name pop-up menu.

Step 6 In the Port Number, Range or Series field, type in: 5060, 16384-16403.
Step 7 In the Description field type in: iChat AV

Step 8 Click OK.
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Frequently Asked Questions (continued)

How do | send or receive a file via iChat when the Mac OSX firewall
is active? -for Macintosh users- Mac OS X 10.2 and later

The following information is from the online Macintosh AppleCare knowledge base:

“iIChat cannot send or receive a file when the Mac OS X firewall is active in its default
state. If you have opened the AIM port, you may be able to receive a file but not send
them.

In its default state, the Mac OS X firewall blocks file transfers using iChat or America
Online AIM software. If either the sender or receiver has turned on the Mac OS X firewall,
the transfer may be blocked.

The simplest workaround is to temporarily turn off the firewall in the Sharing preference
pane on both computers. This is required for the sender. However, the receiver may keep
the firewall on if the AIM port is open. To open the AIM port:

Step 1 Choose Apple menu > System Preferences.

Step 2 Choose View > Sharing.
Step 3 Click the Firewall tab.
Step 4 Click New.

Step 5 Choose AOL IM from the Port Name pop-up menu. The number 5190
should already be filled in for you.

Step 6 Click OK.

If you do not want to turn off the firewall at the sending computer, a different file sharing
service may be used instead of iChat. The types of file sharing available in Mac OS X are
outlined in technical document 106461, "Mac OS X: File Sharing" in the AppleCare Knowl-
edge base online.

Note: If you use a file sharing service when the firewall is turned on, be sure to click the
Firewall tab and select the service you have chosen in the "Allow" list. If you do not do
this, the firewall will also block the file sharing service. “
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Frequently Asked Questions (continued)

What is NAT?

NAT stands for Network Address Translator. Itis proposed and described in RFC-
1631 and is used for solving the IP Address depletion problem. Basically, each NAT
box has a table consisting of pairs of local IP Addresses and globally unique
addresses, by which the box can “translate” the local IP Addresses to global address
and vice versa. Simply put, it is a method of connecting multiple computers to the
Internet (or any other IP network) using one IP Address.

D-Link’s broadband routers support NAT. With proper configuration, multiple users can
access the Internet using a single account via the NAT device.

For more information on RFC-1631: The IP Network Address Translator (NAT), visit
http://www.fags.org/rfcs/rfc1631.html
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Technical Support

You can find software updates and user documentation on the D-Link website.

D-Link provides free technical support for customers within the United States and
within Canada for the duration of the warranty period on this product.

U.S. and Canadian customers can contact D-Link technical support through our web
site, or by phone.

Tech Support for customers within the United States:

D-Link Technical Support over the Telephone:
(877) 453-5465
24 hours a day, seven days a week.

D-Link Technical Support over the Internet:
http://support.dlink.com
email:support@dlink.com

Tech Support for customers within Canada:

D-Link Technical Support over the Telephone:
(800) 361-5265
Monday to Friday 8:30am to 9:00pm EST

D-Link Technical Support over the Internet:
http://support.dlink.ca
email:support@dlink.ca

When contacting technical support, please provide the following information:
* Serial number of the unit
» Model number or product name

 Software type and version number
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Warranty and Registration
(USA only)

Subject to the terms and conditions set forth herein, D-Link Systems, Inc. (“D-Link”) provides this Limited
warranty for its product only to the person or entity that originally purchased the product from:

. D-Link or its authorized reseller or distributor and

. Products purchased and delivered within the fifty states of the United States, the District of
Columbia, U.S. Possessions or Protectorates, U.S. Military Installations, addresses with an
APO or FPO.

Limited Warranty: D-Link warrants that the hardware portion of the D-Link products described
below will be free from material defects in workmanship and materials from the date of original retail
purchase of the product, for the period set forth below applicable to the product type (“Warranty
Period”), except as otherwise stated herein.

3-Year Limited Warranty for the Product(s) is defined as follows:

. Hardware (excluding power supplies and fans) Three (3) Years
. Power Supplies and Fans One (1) Year
. Spare parts and spare kits Ninety (90) days

D-Link’s sole obligation shall be to repair or replace the defective Hardware during the Warranty Period
at no charge to the original owner or to refund at D-Link’s sole discretion. Such repair or replacement will
be rendered by D-Link at an Authorized D-Link Service Office. The replacement Hardware need not be
new or have an identical make, model or part. D-Link may in its sole discretion replace the defective
Hardware (or any part thereof) with any reconditioned product that D-Link reasonably determines is
substantially equivalent (or superior) in all material respects to the defective Hardware. Repaired or
replacement Hardware will be warranted for the remainder of the original Warranty Period from the date
of original retail purchase. If a material defect is incapable of correction, or if D-Link determines in its sole
discretion that it is not practical to repair or replace the defective Hardware, the price paid by the original
purchaser for the defective Hardware will be refunded by D-Link upon return to D-Link of the defective
Hardware. All Hardware (or part thereof) that is replaced by D-Link, or for which the purchase price is
refunded, shall become the property of D-Link upon replacement or refund.

Limited Software Warranty: D-Link warrants that the software portion of the product (“Software”)
will substantially conform to D-Link’s then current functional specifications for the Software, as set forth
in the applicable documentation, from the date of original retail purchase of the Software for a period of
ninety (90) days (“Warranty Period”), provided that the Software is properly installed on approved
hardware and operated as contemplated in its documentation. D-Link further warrants that, during the
Warranty Period, the magnetic media on which D-Link delivers the Software will be free of physical
defects. D-Link’s sole obligation shall be to replace the non-conforming Software (or defective media)
with software that substantially conforms to D-Link’s functional specifications for the Software or to
refund at D-Link’'s sole discretion. Except as otherwise agreed by D-Link in writing, the replacement
Software is provided only to the original licensee, and is subject to the terms and conditions of the
license granted by D-Link for the Software. Software will be warranted for the remainder of the original
Warranty Period from the date or original retail purchase. If a material non-conformance is incapable of
correction, or if D-Link determines in its sole discretion that it is not practical to replace the non-
conforming Software, the price paid by the original licensee for the non-conforming Software will be
refunded by D-Link; provided that the non-conforming Software (and all copies thereof) is first returned
to D-Link. The license granted respecting any Software for which a refund is given automatically
terminates.

Non-Applicability of Warranty: The Limited Warranty provided hereunder for hardware and software
of D-Link’s products will not be applied to and does not cover any refurbished product and any product
purchased through the inventory clearance or liquidation sale or other sales in which D-Link, the sellers,
or the liquidators expressly disclaim their warranty obligation pertaining to the product and in that case,
the product is being sold “As-Is” without any warranty whatsoever including, without limitation, the
Limited Warranty as described herein, notwithstanding anything stated herein to the contrary.

Submitting A Claim: The customer shall return the product to the original purchase point based on its

return policy. In case the return policy period has expired and the product is within warranty, the
customer shall submit a claim to D-Link as outlined below:
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. The customer must submit with the product as part of the claim a written description of the
Hardware defect or Software nonconformance in sufficient detail to allow D-Link to confirm
the same.

. The original product owner must obtain a Return Material Authorization (“RMA”) number from
the Authorized D-Link Service Office and, if requested, provide written proof of purchase of
the product (such as a copy of the dated purchase invoice for the product) before the
warranty service is provided.

. After an RMA number is issued, the defective product must be packaged securely in the
original or other suitable shipping package to ensure that it will not be damaged in transit, and
the RMA number must be prominently marked on the outside of the package. Do notinclude any
manuals or accessories in the shipping package. D-Link will only replace the defective portion
of the Product and will not ship back any accessories.

. The customer is responsible for all in-bound shipping charges to D-Link. No Cash on Delivery
(“COD") is allowed. Products sent COD will either be rejected by D-Link or become the
property of D-Link. Products shall be fully insured by the customer. D-Link will not be held
responsible for any packages that are lost in transit to D-Link. The repaired or replaced
packages will be shipped to the customer via UPS Ground or any common carrier selected by
D-Link, with shipping charges prepaid. Expedited shipping is available if shipping charges are
prepaid by the customer and upon request.

Return Merchandise Ship-To Address
USA 53 Discovery Drive, Irvine, CA 92618
Canada: 2180 Winston Park Dr|ve Oakville, ON, L6H 5W1 (Visit http://www.dlink.ca for detailed
warranty information within Canada)

D-Link may reject or return any product that is not packaged and shipped in strict compliance with the
foregoing requirements, or for which an RMA number is not visible from the outside of the package. The
product owner agrees to pay D-Link’s reasonable handling and return shipping charges for any product
that is not packaged and shipped in accordance with the foregoing requirements, or that is determined
by D-Link not to be defective or non-conforming.

What Is Not Covered: This limited warranty provided by D-Link does not cover: Products, if in D-Link’s
judgment, have been subjected to abuse, accident, alteration, modification, tampering, negligence, misuse,
faulty installation, lack of reasonable care, repair or service in any way that is not contemplated in the
documentation for the product, or if the model or serial number has been altered, tampered with, defaced
or removed; Initial installation, installation and removal of the product for repair, and shipping costs;
Operational adjustments covered in the operating manual for the product, and normal maintenance;
Damage that occurs in shipment, due to act of God, failures due to power surge, and cosmetic damage;
Any hardware, software, firmware or other products or services provided by anyone other than D-
Link; Products that have been purchased from inventory clearance or liquidation sales or other sales in
which D-Link, the sellers, or the liquidators expressly disclaim their warranty obligation pertaining to the
product. Repair by anyone other than D-Link or an Authorized D-Link Service Office will void this
Warranty.

Disclaimer of Other Warranties: EXCEPT FOR THE LIMITED WARRANTY SPECIFIED HEREIN, THE
PRODUCT IS PROVIDED “AS-IS” WITHOUT ANY WARRANTY OF ANY KIND WHATSOEVER INCLUDING,
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY, FITNESS FORAPARTICULAR PURPOSE
AND NON-INFRINGEMENT. IF ANY IMPLIED WARRANTY CANNOT BE DISCLAIMED INANY TERRITORY
WHERE APRODUCT IS SOLD, THE DURATION OF SUCH IMPLIED WARRANTY SHALL BE LIMITED TO
NINETY (90) DAYS. EXCEPT AS EXPRESSLY COVERED UNDER THE LIMITED WARRANTY PROVIDED
HEREIN, THE ENTIRE RISKAS TO THE QUALITY, SELECTION AND PERFORMANCE OF THE PRODUCT IS
WITH THE PURCHASER OF THE PRODUCT.
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LIABILITY OF D-LINK UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE PRICE OF THE PRODUCT
COVERED BY THE WARRANTY. THE FOREGOING EXPRESS WRITTEN WARRANTIES AND REMEDIES
ARE EXCLUSIVEAND ARE IN LIEU OF ANY OTHER WARRANTIES OR REMEDIES, EXPRESS, IMPLIED OR
STATUTORY.

Governing Law: This Limited Warranty shall be governed by the laws of the State of California. Some
states do not allow exclusion or limitation of incidental or consequential damages, or limitations on how
long an implied warranty lasts, so the foregoing limitations and exclusions may not apply. This limited
warranty provides specific legal rights and the product owner may also have other rights which vary
from state to state.

Trademarks: D-Link is a registered trademark of D-Link Systems, Inc. Other trademarks or registered
trademarks are the property of their respective manufacturers or owners.

Copyright Statement: No part of this publication or documentation accompanying this Product may
be reproduced in any form or by any means or used to make any derivative such as translation,
transformation, or adaptation without permission from D-Link Corporation/D-Link Systems, Inc., as
stipulated by the United States Copyright Act of 1976. Contents are subject to change without prior

notice. Copyright® 2002 by D-Link Corporation/D-Link Systems, Inc. All rights reserved.

CE Mark Warning: This is a Class B product. In a domestic environment, this product may cause radio
interference, in which case the user may be required to take adequate measures.

FCC Statement: This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communication. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

. Reorient or relocate the receiving antenna.

. Increase the separation between the equipment and receiver.
. Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

. Consult the dealer or an experienced radio/TV technician for help.

For detailed warranty outside the United States, please contact corresponding local
D-Link office.

FCC Caution:

The manufacturer is not responsible for any radio or TV interference caused by unauthorized
modifications to this equipment; such modifications could void the user’s authority to operate the
equipment.

(1) The devices are restricted to indoor operations within the 5.15 to 5.25GHz range. (2) For this
device to operate in the 5.15 to 5.25GHz range, the devices must use integral antennas.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. The antenna(s) used for this equipment must be installed to provide a separation
distance of at least eight inches (20 cm) from all persons.

This equipment must not be operated in conjunction with any other antenna.

[ Register your D-Link product online at http://support.dlink.com/register/ ]
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